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MODUL 1 

PENGENALAN PEMROGRAMAN JAVA 

1.  

 

MODUL 1 
PENGENALAN PEMROGRAMAN JAVA 
 

Pokok Pembahasan : 

• Teknologi pemrograman Java 

• Fitur pemrograman Java 

• Lingkungan Kerja IDE Netbeans 

• Latihan/Percobaan 
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1.1 Bahasa Pemrograman Java 

 Java dikembangkan oleh sebuah tim yang dipimpin oleh James Gosling di 

perusahaan Sun Microsystems. Sebelumnya bernama “Oak” yang dirancang pada 

tahun 1991 untuk digunakan dalam chip tertanam di peralatan elektronik. Pada tahun 

1995, berganti nama menjadi Java dan didesain ulang untuk mengembangkan aplikasi 

web. Pada tahun 2010, Sun Microsystems diambil-alih oleh perusahaan Oracle. Java 

merupakan bahasa pemrograman yang sangat populer. Pengembangan 

pemrograman Java yang cepat dan kompatibel dapat dilihat dari karakteristik 

desainnya, dimana Anda dapat menulis program sekali dan dapat 

dijalankan/dieksekusi dimana saja.  

 

1.1.1 Teknologi Java 

• Sebuah Bahasa Pemrograman 

Sebagai sebuah bahasa pemrograman, Java dapat membuat seluruh bentuk 

aplikasi, desktop, web dan lainnya, sebagaimana dibuat dengan menggunakan 

bahasa pemrograman konvensional yang lain. Java adalah bahasa 

pemrograman yang berorientasi objek (dibahas secara khusus pada Buku 

Pemrograman Berorientasi Objek) dan dapat dijalankan pada berbagai platform 

sistem operasi. Perkembangan Java tidak hanya terfokus pada satu sistem 

operasi, tetapi dikembangkan untuk berbagai sIstem operasi dan bersifat open 

source. 

 

• Sebuah Development Environment 

Sebagai sebuah peralatan pembangun, teknologi Java menyediakan banyak 

tools : compiler, interpreter, penyusun dokumentasi, paket kelas dan 

sebagainya. 

 

• Sebuah Aplikasi 

Aplikasi dengan teknologi Java secara umum adalah aplikasi serba guna yang 

dapat dijalankan pada seluruh mesin yang memiliki Java Runtime Environment 

(JRE). 

 

• Sebuah Deployment Environment 

Terdapat dua komponen utama dari Deployment Environment. Yang pertama 

adalah JRE, yang terdapat pada paket J2SDK, mengandung kelas–kelas untuk 

semua paket teknologi Java yang meliputi kelas dasar dari Java, komponen GUI 

dan sebagainya. Komponen yang lain terdapat pada Web Browser. Hampir 
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seluruh Web Browser komersial menyediakan interpreter dan runtime 

environment dari teknologi Java. 

 

 

1.1.2 Fitur dari Java 

• Java Virtual Machine (JVM)  

JVM adalah sebuah mesin imajiner (maya) yang bekerja dengan menyerupai 

aplikasi pada sebuah mesin nyata. JVM menyediakan spesifikasi hardware dan 

platform dimana kompilasi kode Java terjadi. Spesifikasi inilah yang membuat 

aplikasi berbasis Java menjadi bebas dari platform manapun karena proses 

kompilasi diselesaikan oleh JVM. Aplikasi program Java diciptakan dengan file 

teks berekstensi .java. Program ini dikompilasi menghasilkan satu berkas 

bytecode berekstensi .class atau lebih. Bytecode adalah serangkaian instruksi 

serupa instruksi kode mesin. Perbedaannya adalah kode mesin harus dijalankan 

pada sistem komputer dimana kompilasi ditujukan, sementara bytecode berjalan 

pada java interpreter yang tersedia di semua platform sistem komputer dan 

sistem operasi. 

 

• Garbage Collection 

Banyak bahasa pemrogaman lain yang mengijinkan seorang programmer 

mengalokasikan memori pada saat dijalankan. Namun, setelah menggunakan 

alokasi memori tersebut, harus terdapat cara untuk menempatkan kembali blok 

memori tersebut supaya program lain dapat menggunakannya. Dalam C, C++ 

dan bahasa lainnya, adalah programmer yang mutlak bertanggung jawab akan 

hal ini. Hal ini dapat menyulitkan bilamana programmer tersebut alpa untuk 

mengembalikan blok memori sehingga menyebabkan situasi yang dikenal 

dengan nama memory leaks. Program Java melakukan garbage collection yang 

berarti program tidak perlu menghapus sendiri objek–objek yang tidak 

digunakan lagi. Fasilitas ini mengurangi beban pengelolaan memori oleh 

programmer dan mengurangi atau mengeliminasi sumber kesalahan terbesar 

yang terdapat pada bahasa yang memungkinkan alokasi dinamis. 

 

• Code Security 

Code Security terimplementasi pada Java melalui penggunaan Java Runtime 

Environment (JRE). Java menggunakan model pengamanan 3 lapis untuk 

melindungi sistem dari untrusted Java Code. 

a. Class-loader  



 

4 

Menangani pemuatan kelas Java ke runtime interpreter. Proses ini 

menyediakan pengamanan dengan memisahkan kelas–kelas yang berasal 

dari local disk dengan kelas–kelas yang diambil dari jaringan. Hal ini 

membatasi aplikasi Trojan karena kelas–kelas yang berasal dari local disk 

yang dimuat terlebih dahulu. 

 

b. Bytecode verifier  

Membaca bytecode sebelum dijalankan dan menjamin bytecode memenuhi 

aturan–aturan dasar bahasa Java. 

 

c. Manajemen keamanan  

Menangani keamanan tingkat aplikasi dengan mengendalikan apakah 

program berhak mengakses sumber daya seperti sistem file, port jaringan, 

proses eksternal dan sistem windowing. Setelah seluruh proses tersebut 

selesai dijalankan, barulah kode program di eksekusi. 

 

Java juga menyediakan beragam teknik pengamanan lain : 

a. Bahasa dirancang untuk mempersulit eksekusi kode perusak.  

Peniadaan pointer merupakan langkah besar pengamanan. Java tidak 

mengenal operasi pointer. Di tangan programmer handal, operasi pointer 

merupakan hal yang luar biasa untuk optimasi dan pembuatan program yang 

efisien serta mengagumkan. Namun mode ini dapat menjadi petaka di 

hadapan programmer jahat. Pointer merupakan sarana luar biasa untuk 

pengaksesan tak diotorisasi. Dengan peniadaan operasi pointer, Java dapat 

menjadi bahasa yang lebih aman. 

 

b. Java memiliki beberapa pengaman terhadap applet.  

Untuk mencegah program bertindak mengganggu media penyimpanan, 

maka applet tidak diperbolehkan melakukan open, read ataupun write 

terhadap berkas secara sembarangan. Karena Java applet dapat membuka 

jendela browser yang baru, maka jendela mempunyai logo Java dan teks 

identifikasi terhadap jendela yang dibuka. Hal ini mencegah jendela pop-up 

menipu sebagai permintaan keterangan username dan password. 

 

 

1.1.3 Fase – Fase Pemrograman Java 

Gambar dibawah ini menjelaskan aliran proses kompilasi dan eksekusi sebuah 

program Java : 



 

5 

 
Gambar 1.1 Fase dari sebuah Program Java 

 

Langkah pertama dalam pembuatan sebuah program berbasis Java adalah 

menuliskan kode program pada text editor. Contoh text editor yang dapat digunakan 

antara lain : notepad, vi, emacs, sub limes dan lain sebagainya. Kode program yang 

dibuat kemudian tersimpan dalam sebuah berkas berekstensi .java. Setelah membuat 

dan menyimpan kode program, kompilasi file yang berisi kode program tersebut 

dengan menggunakan Java Compiler. Hasil dari kompilasi berupa berkas bytecode 

dengan ekstensi .class. Berkas yang mengandung bytecode tersebut kemudian akan 

dikonversikan oleh Java Interpreter menjadi bahasa mesin sesuai dengan jenis dan 

platform yang digunakan. Tabel berikut menggambarkan fase dari sebuah program 

java 

 

Tabel 1.1 Fase Sebuah Pemrograman Java 

PROSES TOOL HASIL 

Menulis kode 
program 

Text editor Berkas berekstensi .java 

Kompilasi program 
Java 

Compiler Berkas berekstensi .class (Java Bytecodes) 

Menjalankan 
program Java 

Interpreter Program Output 

 

 

1.1.4 Lingkungan Kerja IDE Netbeans 

 Lingkungan kerja dari IDE NetBeans secara umum dapat dilihat pada gambar 

1.2. Adapun keterangan mengenai lingkungan kerja IDE NetBeans adalah sebagai 

berikut : 

1. Menu bar 

Merupakan kumpulan menu yang menyediakan fitur atau fungsi, dan fasilitas 

tertentu. 
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2. Toolbar 

Merupakan kumpulan tombol pintas untuk menjalankan fungsi atau fitur 

tertentu berupa gambar icon. 

 

 
Gambar 1.2 Lingkungan Kerja IDE NetBeans 

 

3. Jendela Projects 

Merupakan area yang menampilkan seluruh daftar projek yang berada dalam 

IDE NetBeans. Untuk menampilkan jendela ‘Projects’ (Gambar 1.3), klik menu 

‘Window’ → ‘Projects’. 

 
Gambar 1.3 Cara Menampilkan Jendela Projects 
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3 
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4. Jendela Navigator 

Merupakan area navigasi baik susunan kode program maupun susunan 

komponen pada lembar perancangan. Untuk menampilkan jendela ‘Navigator’ 
(Gambar 1.4), klik menu ‘Window’ → ‘Navigator’. 

 
Gambar 1.4 Cara Menampilkan Jendela Navigator 

 

5. Lembar Perancangan 

Merupakan tempat perancangan antar muka (Gambar 1.5), perancangan kode 

program (Gambar 1.6), dan riwayat pekerjaan. 

 

6. Jendela Palette 

Merupakan area yang menyediakan komponen untuk merancang antar muka 

berbasis Graphic User Interface (GUI) pada lembar perancangan. Untuk 

menampilkan jendela ‘Palette’ (Gambar 1.7), Klik menu ‘Windows’ → ‘IDE 
Tools’ → ‘Palette’. 
 

 
Gambar 1.5 Tampilan Perancangan Antar Muka  
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Gambar 1.6 Tampilan Perancangan Kode Program 

 

7. Jendela Properties 

Merupakan area yang berisi item-item properti dari suatu komponen yang 

digunakan pada lembar perancangan. Pada area ini pula dapat ditentukan nilai 

atau data suatu komponen agar pengolahan komponen atau nilai menjadi lebih 

mudah. Untuk menampilkan jendela ‘Properties’ (Gambar 1.8), Klik menu 

‘Windows’ → ‘IDE Tools’ → ‘Properties’. 

 
Gambar 1.7 Cara Menampilkan Jendela Palette 
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Gambar 1.8 Cara Menampilkan Jendela Properties 

 

 

1.2 Percobaan 

1.2.1 Instalasi Java + Netbeans 

 Dalam percobaan berikut ini, akan dijelaskan langkah-langkah dalam melakukan 

instalasi Java dan Netbeans. File-file yang dibutuhkan yaitu Java Development Kit 

(JDK) dan Netbeand IDE yang dapat diunduh secara gratis di 

https://www.oracle.com/technetwork/java/index.html untuk JDK dan  

https://netbeans.org/downloads/index.html untuk Netbeans IDE. 

 

1. Menginstall software Java Development Kit (pada contoh di bawah 

menggunakan jdk-8) di windows komputer dengan langkah-langkahnya sebagai 

berikut : 

a. Setelah JDK berhasil diunduh, double click pada ‘jdk installer’.  

 
Java Development Kit Installer 

 

b. Pada halaman ‘Welcome’, klik tombol ‘Next >’ untuk melanjutkan ke proses 
berikutnya. 

https://www.oracle.com/technetwork/java/index.html
https://netbeans.org/downloads/index.html
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Halaman Welcome 

 

c. Pada halaman ‘Custom Setup’, lokasi instalasi dapat diubah dengan klik 
tombol ‘Change’. klik tombol ‘Next >’ untuk melanjutkan ke proses instalasi 

JDK. Pada halaman tersebut menampilkan informasi progres instalasi JDK. 

 
Halaman Custom Setup 
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Halaman Proses Instalasi JDK 

 

d. Setelah selesai proses instalasi JDK, proses berikutnya adalah instalasi 

Java Runtime Environment (JRE). Halaman instalasi JRE, lokasi instalasi 

dapat diubah dengan klik tombol ‘Change…’. Klik tombol ‘Next >’ untuk 
melanjutkan ke proses instalasi. Pada halaman tersebut menampilkan 

informasi progres instalasi JRE. Setelah selesai proses instalasi maka akan 

tampil halaman hasil yang berisi informasi status instalasi. 

 
Halaman Instalasi JRE 
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Halaman Proses Instalasi JRE 

 

 
Halaman Hasil 

 

2. Menginstall text editor dan console NetBeans IDE dengan langkah-langkah 

adalah sebagai berikut : 

a. Setelah NetBeans berhasil diunduh, double click pada ‘netbeans’. 

 
NetBeans Installer 
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Configuring the Installer 

 

b. Halaman pertama yang tampil adalah halaman ‘Welcome’. Pada halaman 

ini, terdapat pilihan untuk instalasi ‘application servers’. Klik tombol ‘Next >’ 
untuk melanjutkan ke proses berikutnya. 

 
Halaman Welcome 

 

c. Halaman selanjutnya adalah halaman ‘License Agreement’. Centang pada 
bagian “I accept the terms in the license agreement”, kemudian klik 

tombol ‘Next >’ untuk melanjutkan ke proses berikutnya. 
 

d. Apabila pada halaman ‘Welcome’ memilih application server, tahap 

berikutnya adalah menentukan lokasi instalasi dari application server. 

Untuk merubah lokasi instalasi yang telah ada, klik tombol ‘Browse…’. Klik 
tombol ‘Next >’ untuk melanjutkan ke proses berikutnya. 
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Halaman License Agreement 

 

 
Halaman Application Server Installation Folder 

 

e. Halaman berikutnya yang tampil adalah halaman ‘Summary’. Klik tombol 

‘Install’ untuk melanjutkan ke proses installasi. 
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Halaman Summary 

 

 
Halaman Proses Instalasi NetBeans IDE 

 

f. Setelah proses instalasi selesai, akan tampil halaman hasil yang berisi 

status hasil instalasi. Klik tombol ‘Finish’. 
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Halaman Hasil 

 

1.2.2 Menambah Projek Baru (New Project) 

 Untuk membuat aplikasi menggunakan Bahasa Pemrograman Java, terlebih 

dahulu membuat projek baru (new project). Berikut langkah-langkah membuat projek 

baru : 

1. Pada layar dekstop, double click NetBeans IDE shortcut untuk menjalankan 

software NetBeans IDE. Selain itu, dapat pula melalui menu windows : 

 
NetBeans IDE shortcut 

 

 
Menu windows 

 

2. Pada tampilan utama software NetBeans, pilih menu ‘File’ → ‘New Project’. 
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Menu ‘New Project’ 
 

3. Pada halaman ‘New Project’, pilih ‘Java’ dibagian Categories dan pilih ‘Java 

Applications’ dibagian Projects kemudian klik tombol ‘Next >’. 

 

 

4. Pada Project Name Isikan nama projek akan dibuat contoh ‘Exercises’. 
Hilangkan centang pada ‘Create Main Class’, kemudian klik ‘Finish’.  
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Catatan : nama projek tidak boleh menggunakan spasi 

 

5. Projek baru akan muncul pada jendela ‘Projects’ (umumnya disisi sebelah kiri). 

 
6. Apabila jendela ‘Projects’ tidak muncul/tampil pada IDE Netbeans, jendela 

‘Projects’ dapat ditampilkan dengan cara : klik menu ‘Window’ → ‘Projects’ 

 
 

1.2.3 Menambah Paket Baru (New Package) 

 Paket (Package) digunakan untuk membuat folder yang dapat mempaketkan 

file-file yang sejenis. Berikut langkah-langkah untuk menambah paket baru : 

1. Klik kanan pada projek ‘Exercises’ → New → ‘Java Package’.  
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2. Tentukan Package Name, sebagai contoh ‘Modul1’. Projek ‘Exercises’ yang 

tampil untuk memastikan bahwa paket terdapat dalam projek tersebut. Klik 

tombol ‘Finish’.  

 
Catatan : nama paket tidak boleh menggunakan spasi. 

 

3. Paket ‘Modul1’ akan muncul didalam projek ‘Exercises’. 
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1.2.4 Menambah Frame Form 

 Menambah Frame Form dapat dilakukan pada paket (package) tertentu atau 

default package. Pada contoh di bawah ini, Frame Form akan ditambahkan pada paket 

“Modul1”. Langkah-langkah untuk menambah Frame Form adalah sebagai berikut : 

1. Klik kanan pada package “Modul1” → New → JFrame Form… 

 
 

2. Tentukan Class Name, sebagai contoh ‘Contoh1’. Project ‘Exercises’ dan 
package ‘Modul1’ yang tampil untuk memastikan bahwa Frame Form terdapat 
dalam projek dan paket tersebut. Klik tombol ‘Finish’. Catatan : nama class 

tidak boleh menggunakan spasi. 
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3. Form ‘Contoh1’ akan muncul didalam paket ‘Modul1’ dengan nama 

‘Contoh1.java’. 

 
 

1.2.5 Merancang Aplikasi 

1. Masukkan komponen ‘Button’ kedalam form. Pada jendela ‘Palette’ pilih kategori 
‘Swing Controls’, kemudian klik kiri ‘Button’. Arahkan pointer mouse kedalam 

form untuk menentukan posisi ‘Button’, kemudian klik kiri sekali lagi. 

 
Catatan! 

Komponen ‘Button’ (tombol) merupakan komponen eksekutor yang digunakan 

untuk menjalankan suatu proses tertentu pada aplikasi yang dibangun dengan 

cara klik kiri. 

 

2. Pada jendela ‘Navigator’, muncul komponen ‘Button’ yang dimasukkan kedalam 
form dengan nama standar ‘jButton1’. 
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Setiap komponen didalam form memiliki nama (variable name) untuk 

membedakan komponen satu dengan komponen lainnya dan memudahkan 

programer untuk mengoperasikan komponen melalui kode program. 

 

3. Untuk mengubah nama variabel dari komponen, klik kanan ‘jButton1’ pada 
jendela navigator kemudian klik ‘Change Variable Name…’ 

 
 

Ubah menjadi ‘btnPesan’. Klik tombol OK. 

 
 

Nama variabel komponen akan berubah pada jendela navigator 
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Pemberian nama variabel pada komponen bermanfaat untuk memudahkan 

programer dalam : 

• Mengenali dan membedakan setiap komponen yang digunakan. 

• Menulis kode program didalam suatu komponen.  

• Memanipulasi data yang dimasukkan dari komponen atau untuk ditampilkan 

ke komponen melalui kode program.  

 

4. Untuk mengubah teks button, klik kanan ‘btnPesan’ pada jendela navigator atau 

klik kanan komponen pada form, kemudian klik ‘Edit Text’. 

 
Ubah menjadi ‘Pesan’ kemudian tekan enter. 
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5. Double click button ‘Pesan’ pada form sehingga muncul tampilan kode program 

untuk menulis kode program pada button ‘btnPesan’ 

 
 

6. Tuliskan kode program berikut: 

 
 

7. Untuk menjalankan program, tekan tombol ‘shift + F6’ pada keyboard atau 
tombol run project pada toolbar. 

 
 

8. Pada program yang berjalan (runtime) klik tombol ‘Pesan’, kemudian muncul 
kotak pesan yang berisi ‘Selamat Belajar Pemrograman Java’. 
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MODUL 2 

DASAR PEMROGRAMAN JAVA 

2.  

 

MODUL 2 

DASAR PEMROGRAMAN JAVA 
 

Pokok Pembahasan : 

• Tipe Data 

• Identifier 

• Operator 

• Latihan 
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2.1 Tipe Data 

 Tipe data merupakan klasifikasi data dengan bertujuan untuk mengenalkan data 

atau nilai yang digunakan kepada kompiler. Dalam pemrograman Java, terdapat dua 

kelompok tipe data yaitu tipe data primitif/sederhana dan tipe data referensi/komposit.  

 

2.1.1 Tipe Data Primitif/Sederhana 

 Tipe data primitif/sederhana yaitu tipe data dasar yang tersedia/tertanam dan 

merupakan keyword dalam pemrograman Java. Tipe data primitif hanya dapat 

menampung satu nilai. Contoh penggunaan tipe data primitif adalah sebagai berikut : 

→ ada 1 nilai yaitu “p” 
→ ada 1 nilai yaitu 100 

→ ada 1 nilai yaitu 20000 

 

Adapun tipe data primitif dalam pemrograman Java dapat dilihat pada tabel 2.1 di 

bawah ini.  

 

Tabel 2.1 Tipe Data Primitif 

Tipe Data Deskripsi Ukuran 
(bit) 

Nilai 
Minimum 

Maksimum 

boolean true / false 1-bit 
  

char Karakter 
Unicode 

16-bit 
  

byte Bilangan 
bulat 

8-bit -127 128 

short Bilangan 
bulat 

16-bit -32768 32767 

int Bilangan 
bulat 

32-bit -2147483648 2147483647 

long Bilangan 
bulat 

64-bit -
9223372036
854775808 

922337203685477580
7 

float Bilangan riil 32-bit 1.401298464
32481707e-
45 

3.4028234663852886
0e+38 

double Bilangan riil 64-bit 4.940656458
41246544e-
324 

1.7976931348623157
0e+308 
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2.1.2 Tipe Data Referensi 

 Tipe data referensi secara umum adalah tipe data buatan yang mereferensikan 

Object atau Class dan bukan merupakan keyword dalam pemrograman Java. Tipe data 

ini dapat menampung lebih dari satu nilai. Contoh penggunaan tipe data referensi 

adalah sebagai berikut :  

→ 10 nilai (termasuk spasi) bertipe char 

→ 5 nilai bertipe short 

→ 5 nilai bertipe int 

 

 

2.1.3 Enumerasi 

 Enumerasi (enum) merupakan tipe data buatan dimana nilai enum dapat 

didefenisikan sendiri sesuai kebutuhan. Nama enum harus dituliskan pada saat 

variabel dideklarasi dan variabel hanya dapat menggunakan nilai yang sudah 

didefenisikan dalam enum tersebut sebagai konstanta. Berikut sintaks atau bentuk 

penulisan enum. 

 
 modifier enum namaEnum { 

   nilai1, nilai2, ..., nilai-n 

 } 

 

Contoh : 
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Keterangan : 

 
 

  
 

 
 

 

2.2 Identifier 

 Identifier merupakan pengenal atau identitas yang berupa nama untuk variabel, 

sub rutin (prosedur atau fungsi), kelas, interface, maupun namespace. Berikut aturan 

penamaan identifier : 

1. Terdiri dari huruf (a-z / A-Z) atau kombinasi dengan angka (0-9). Namun, tidak 

boleh diawali dengan angka. 

2. Bersifat case sensitive yaitu membedakan penggunaan huruf besar dan huruf 

kecil. 

3. Tidak diperbolehkan menggunakan spasi. Untuk membuat pemisah dapat 

menggunakan simbol underscore (_). 

4. Tidak diperbolehkan menggunakan kata keyword dan simbol-simbol operator 

yang dikenal oleh pemrograman Java. 

 

Contoh :  

 → identifier nilai_uas berupa variabel 

 

 → identifier DeretAngka berupa class 

 

 

 → identifier CekGanjil berupa fungsi 

 

 

 

 

Hasil 

defenisi enum 
nilai 
enum 

deklarasi variabel menggunakan enum 

akses nilai enum 
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2.3 Operator 

 Secara umum, operator dalam bahasa pemrograman berupa simbol yang 

menjalankan operasi tertentu. Terdapat beberapa operator dalam pemrograman java 

yaitu : 

 

2.3.1 Operator Aritmatika 

 Operator ini menjalankan operasi bilangan dasar (aritmatika) yaitu penjumlahan 

(+), pengurangan (-), perkalian (*), pembagian (/), dan modulus atau modulo (%). 

Contoh : 

                   
 

2.3.2 Operator Increment/Decrement 

 Operator ini menjalankan operasi penjumlahan dengan kelipatan 1 (increment) 

dan operasi pengurangan dengan kelipatan 1 (decrement) dari nilai variabel 

sebelumnya. Operator increment (++) dan decrement (--) dapat ditempat pada awal 

maupun akhir variabel. Contoh : 

                 
 

Pembahasan : 
A++ → A = A + 1 B-- → B = B - 1 

 → A = 5 + 1  → B = 3 - 1 

 → A = 6  → B = 2 

 

2.3.3 Operator Penugasan (Assignment) 

 Operator ini mirip seperti operator increment/decrement namun lebih variatif. 

Operator penugasan dapat menggunakan seluruh operasi aritmatika dengan kelipatan 

angka yang berbeda-beda. Contoh : 

 

Hasil 

Hasil 
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Pembahasan : 
A+=2 → A = A + 2 B-=3 → B = B - 3 

 → A = 5 + 2  → B = 5 – 3 
 → A = 7  → B = 2 
 

C*=4 → C = C * 4 D/=5 → D = D / 5 

 → C = 5 * 4  → D = 5 / 5 

 → C = 20  → D = 1 
 

E%=6 → E = E % 6 

 → E = 5 % 6 

 → E = 5 

 

2.3.4 Operator Pembanding 

 Operator ini disebut operator relasi yaitu operator yang berfungsi untuk 

mengetahui kebenaran dari hubungan nilai operan kanan dan kiri dengan cara 

membandingkannya. Operator ini akan menghasilkan nilai bertipe boolean yaitu 

True/False. 

 

Tabel 2.2 Operator Pembanding 

Operator Keterangan 

== Sama dengan 

!= Tidak sama dengan 

> Lebih besar 

>= Lebih besar sama dengan 

< Lebih kecil 

<= Lebih kecil sama dengan 

 

Contoh : 

       
 

Hasil 

Hasil 
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2.3.5 Operator Logika 

 Seperti halnya operator pembanding, operator logika juga termasuk kedalam 

operasi relasi yang berfungsi untuk mengetahui kebenaran dari hubungan nilai operan 

kanan dan kiri serta menghasilkan nilai bertipe boolean. Namun, perbedaannya adalah 

operator logika hanya menghubungkan nilai operan bertipe boolean saja.  

 

Tabel 2.3 Operator Logika 

Operator Nama Keterangan 

&& dan (and) Menghasilkan true jika hanya kedua nilai operan bernilai 
true 

|| atau (or) Menghasilkan true salah satu nilai operan bernilai true 

! tidak (not) Menghasilkan kebalikan nilai operan 

 

Contoh : 

Operator logika and (&&) 

     
 

Operator logika or (||) 

      
 

Operator logika not (!) 

    

 

 

 

 

2.3.6 Operator Bitwise 

 Operasi bitwise adalah operasi pengolahanan/manipulasi bit atau bilangan biner 

(0/1). Angka 0 menjadi nilai false dan angka 1 menjadi nilai true. Setiap nilai baik angka 

(0-9) maupun huruf (a-z dan A-Z) akan diubah kedalam bentuk bilangan biner 

kemudian dioleh sesuai dengan operator bitwise yang digunakan. Adapun operator 

bitwise dapat dilihat pada tabel 2.4 di bawah ini. 

 

Hasil 

Hasil 

Hasil 
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Tabel 2.4 Operator Bitwise 

Operator Nama Keterangan 

& And Sama seperti operator logika and 

| Or Sama seperti operator logika or 

^ XOR 
(Exclusive 

Or) 

Menghasilkan true jika salah satu nilai operan bernilai 
true dan salah satu operan bernilai false 

~ Not Sama seperti operator logika not 

<< Left Shift Menggeser bit beberapa digit ke kiri 

>> Right Shift Menggeser bit beberapa digit ke kanan 

 

Contoh : 

a) Operator AND (&) 

 

 

 
 

Pembahasan : 

• Nilai 19 dan 85 (merupakan bilangan desimal dalam tabel ASCII) dikonversi 

menjadi bilangan biner. 

• Bilangan biner dari masing-masing angka tersebut akan direlasikan dengan 

logika AND (lihat operator logika AND) sesuai dengan urutan digitnya. 

• Hasil relasi logika AND dikonversikan kembali menjadi bilangan desimal yaitu 

17. 

 

A=19 → 0 0 0 1 0 0 1 1 
bentuk 

biner 
B=85 → 0 1 0 1 0 1 0 1 

C= → 0 0 0 1 0 0 0 1 

C=     16 + 1 = 17 

 

b) Operator OR (|) 

 

Hasil 
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Pembahasan : 

• Nilai 19 dan 85 (merupakan bilangan desimal dalam tabel ASCII) dikonversi 

menjadi bilangan biner. 

• Bilangan biner dari masing-masing angka tersebut akan direlasikan dengan 

logika OR (lihat operator logika OR) sesuai dengan urutan digitnya. 

• Hasil relasi logika OR dikonversikan kembali menjadi bilangan desimal yaitu 

87. 

 

A=19 → 0 0 0 1 0 0 1 1 
bentuk 

biner 
B=85 → 0 1 0 1 0 1 0 1 

C= → 0 1 0 1 0 1 1 1 

C=   64 + 16 + 4 2 1 = 87 

 

c) Operator XOR (^) 

 

 

 
 

Pembahasan : 

• Nilai 19 dan 85 (merupakan bilangan desimal dalam tabel ASCII) dikonversi 

menjadi bilangan biner. 

• Bilangan biner dari masing-masing angka tersebut akan direlasikan dengan 

logika XOR sesuai dengan urutan digitnya. 

• Logika XOR akan menghasilkan nilai true jika kedua operan memiliki nilai yang 

berbeda. 

• Hasil relasi logika XOR dikonversikan kembali menjadi bilangan desimal yaitu 

70. 

Hasil 

Hasil 

+ + 
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A=19 → 0 0 0 1 0 0 1 1 
bentuk 

biner 
B=85 → 0 1 0 1 0 1 0 1 

C= → 0 1 0 0 0 1 1 0 

C=   64 + 4 2  = 70 

 

d) Operator Left Shift (<<) 

 

 

 
 

Pembahasan : 

• Nilai 19 (merupakan bilangan desimal dalam tabel ASCII) dikonversi menjadi 

bilangan biner. 

• Urutan bilangan biner digeser ke kiri sejauh 3 langkah. 

• Hasil pergeseran bilangan binar tersebut dikonversikan kembali menjadi 

bilangan desimal yaitu 152. 

A= 19 → 0 0 0 1 0 0 1 1  

  pergeseran ke-1 0 0 1 0 0 1 1 0  

  pergeseran ke-2 0 1 0 0 1 1 0 0  

  pergeseran ke-3 1 0 0 1 1 0 0 0  

C=   128 + 16 8    = 152 

 

e) Operator Right Shift (>>) 

 

 

 
 

 

 

Hasil 

Hasil 

+ 

+ 
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Pembahasan : 

• Nilai 85 (merupakan bilangan desimal dalam tabel ASCII) dikonversi menjadi 

bilangan biner. 

• Urutan bilangan biner digeser ke kanan sejauh 3 langkah. 

• Hasil pergeseran bilangan biner tersebut dikonversikan kembali menjadi 

bilangan desimal yaitu 10. 

 

B= 85  0 1 0 1 0 1 0 1  

  pergeseran ke-1 0 0 1 0 1 0 1 0  

  pergeseran ke-2 0 0 0 1 0 1 0 1  

  pergeseran ke-3 0 0 0 0 1 0 1 0  

C=       8 + 2  = 10 

 

 

2.3.7 Operator Ternary 

 Konsep kerja operator ini mirip seperti pernyataan IF dengan 2 kondisi, namun 

disederhanakan menjadi 1 baris berupa pertanyaan. Contoh  

 

 

 
Pembahasan : 

 
 

 

Operator Ternary terdiri dari 3 parameter yaitu : 

1. Variabel yaitu bilangan dan Kriteria/Kondisi yaitu (B==1). 

2. Nilai jika kriteria/kondisi terpenuhi (bernilai true). 

3. Nilai jika kriteria/kondisi tidak terpenuhi (bernilai false).  

Adapun nilai yang terpilih akan disimpan pada variabel yang tertulis pada parameter 1 

yaitu bilangan. 

 

 

Hasil 

1 2 3 
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2.4 Latihan 

2.4.1 Aplikasi Kalkulator1 

 Berikut adalah percobaan membuat aplikasi kalkulator sederhana untuk 

menggunakan operator aritmatika. 

1. Masih menggunakan projek sebelumnya pada modul 1 yaitu ‘Exercises’. 
2. Apabila projek tersebut tidak ada, maka buatlah projek pada NetBeans IDE 

dengan cara yang sama seperti membuat projek (New Project) pada percobaan 

modul 1. 

 

3. Tambahkan paket (Java Package) pada projek ‘Exercises’ dengan langkah-

langkah seperti pada percobaan modul 1 (New Package). Beri nama paket 

dengan ‘Modul2’. 

 
 

4. Tambahkan ‘JFrame Form’ pada paket ‘Modul2’ dengan langkah-langkah 

seperti pada percobaan modul 1 (menambah frame form). Beri nama JFrame 

Form dengan ‘Kalkulator1’. 
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5. Desain form menggunakan beberapa komponen dari jendela palette seperti 

berikut ini : 

 
Catatan! 

✓ Komponen ‘Label’ merupakan komponen keterangan yang digunakan 

untuk memberikan keterangan pada komponen lain atau menampilkan 

informasi tertentu. 

✓ Komponen ‘Text Filed’ merupakan komponen entri data yang digunakan 

untuk memasukkan nilai/data dengan cara diketik pada saat program 

dijalankan/running. Selain memasukkan nilai/data, komponen ini juga 

dapat menampilkan nilai/data yang bersifat non-editable. 

 

6. Ubah susunan dan nilai properti masing-masing komponen seperti berikut ini. 
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Komponen 
Nama 

Variabel 
Properties 

Desktop Pane - background : Yellow 

jLabel1 - text = INPUT NILAI PERTAMA 

jLabel2 - text = INPUT NILAI KEDUA 

jLabel3 - text = HASIL 

jTextField1 txtnilai1 text = <kosongkan> 

jTextField2 txtnilai2 text = <kosongkan> 

jTextField3 txthasil text = <kosongkan> 

  editable = False  

jButton1 btntambah text = + 

jButton2 btnkurang text = - 

jButton3 btnkali text = x 

jButton4 btnbagi text = / 

 

7. Seluruh komponen yang digunakan (beserta nama variabel dari komponen) 

dapat dilihat pada jendela Navigator. 
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8. Tulis kode program dibawah pada masing-masing button dengan cara seperti 

berikut : 

Klik kanan komponen btntambah pada jendela navigator → Event → Action → 

klik actionPerformed. Ketikan kode program dibawah ini 

 

 

Klik kanan komponen btnkurang pada jendela navigator → Event → Action → 

klik actionPerformed. Ketikan kode program dibawah ini 

 

 

 

Klik kanan komponen btnbagi pada jendela navigator → Event → Action → klik 

actionPerformed. Ketikan kode program dibawah ini 
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Klik kanan komponen btnkali pada jendela navigator → Event → Action → klik 

actionPerformed. Ketikan kode program dibawah ini 

 

 

Apabila terdapat kode program dengan garis bawah berwarna merah dan tanda 

seperti pada gambar  berarti terdapat kesalahan pada baris dan 

kode program tersebut. 

 

9. Untuk menjalankan program, klik menu Run → Run File (Shift + F6). 
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MODUL 3 

STRUKTUR PENSELEKSIAN 

3.  

 

MODUL 3 

STRUKTUR PENSELEKSIAN 

 

Topik Pembahasan : 

• Pernyataan if 

• Pernyataan if-else 

• Pernyataan if-else-if 

• Pernyataan switch 

• Penseleksian Bersarang 

• Latihan 
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3.1 Pernyataan if 

 Pernyataan if digunakan untuk menyeleksi 1 kondisi/keadaan dengan 1 

kriteria/persyaratan (boolean_expression). Kondisi (dapat berupa blok kode program) 

akan dieksekusi jika dan hanya jika kriteria terpenuhi atau bernilai benar (true). Sintaks 

atau bentuk penulisan pernyataan if adalah sebagai berikut : 

 
if( boolean_expression )  

statement; → kondisi 

 
atau 
 
if( boolean_expression ){ 
 statement1; 
 statement2;   kondisi  

. . . ; 
} 

 

Keterangan : 

boolean_expression merupakan kriteria dari suatu kondisi berupa operator 

pembanding. 

 

 

3.2 Pernyataan if-else 

 Pernyataan if-else digunakan untuk menyeleksi 2 kondisi/keadaan dengan 1 

kriteria/persyaratan. Apabila kriteria pertama terpenuhi atau bernilai benar (true) maka 

kondisi ke-1 akan dieksekusi. Namun, jika kriteria pertama tidak terpenuhi atau bernilai 

salah (false) maka secara otomatis kondisi ke-2 akan dieksekusi. Sintaks atau bentuk 

penulisan pernyataan if-else adalah sebagai berikut : 

 
if( boolean_expression ) 

  statement;  → kondisi ke-1 

else 
 statement;  → kondisi ke-2 

 

atau 

 

if( boolean_expression ) { 
 statement1; 
 statement2;     kondisi ke-1 

…; 
} else { 
 statement3; 
 statement4;          kondisi ke-2 

 …; 
} 
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Contoh : 

 

 

 
Pembahasan: 
Operator pembanding yang digunakan sebagai kriteria adalah sama dengan (==). Nilai 
variabel ‘pwd’ adalah 123 sehingga hasil operator pembanding menjadi 123==123 
(dibaca ‘benarkah 123 sama dengan 123’) dan hasilnya adalah benar. Oleh karena 
hasil dari operator pembanding bernilai benar atau kriteria terpenuhi maka program 
akan memilih kondisi ke-1. Apabila hasil operator pembanding bernilai salah atau 
kriteria tidak terpenuhi maka program akan memilih kondisi ke-2. 
 
 
3.3 Pernyataan if-else-if 

 Pernyataan if-else if dapat digunakan untuk menyeleksi beberapa kondisi (2 atau 

lebih) dengan beberapa kriteria (2 atau lebih) pula. Kondisi struktur seperti ini 

mengijinkan kita untuk membuat seleksi kondisi yang lebih kompleks. Sintaks atau 

bentuk penulisan pernyataan if-else if adalah sebagai berikut : 

 
if( boolean_expression1 ){ 
 statement1; 
 statement2;  
 
} else if( boolean_expression2) { 
 statement3; 
 statement4; 
 
} else { 
 statement5; 
 statement6; 
} 

 

Keterangan : 

Kondisi ke-3 akan dieksekusi secara otomatis apabila seluruh kriteria 

(boolean_expression) sebelumnya tidak terpenuhi. 

 

 

Hasil 

Kondisi ke-1 

Kondisi ke-2 

Kondisi ke-3 
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Contoh 1: 

 

 

 

 

 

 

 

 

 

  

  
Pembahasan : 

Ada 3 kriteria yang digunakan pada contoh di atas dengan operator pembanding yang 

berbeda-beda. Program akan memulai seleksi dari pernyataan if pertama atau kriteria-

1. 

• Kriteria-1 menggunakan operator sama dengan (==) yaitu angka == 5 (dibaca 

‘benarkah 8 = 5’) dan hasilnya adalah salah (false) sehingga kriteria-1 tidak 

terpenuhi. Oleh karena itu, program akan melanjutkan proses seleksi ke 

pernyataan if kedua atau kriteria-2. 

 

• Kriteria-2 menggunakan operator lebih kecil sama dengan (<=) yaitu angka <= 

5 (dibaca ‘benarkah 8<=5’) dan hasilnya adalah salah (false) sehingga kriteria-

2 tidak terpenuhi. Oleh karena itu, program akan melanjutkan proses seleksi 

ke pernyataan if ketiga atau kriteria-3. 

 

• Kriteria-3 menggunakan operator lebih besar sama dengan (>=) yaitu angka 

>= 5 (dibaca ‘benarkah 8>=5’) dan hasilnya adalah benar (true) atau kriteria-3 

terpenuhi. Oleh karena itu, program akan memilih kondisi ke 3 dan 

menghentikan proses seleksi. 

 

  

Hasil 

Melakukan seleksi ke-1 

Karena seleksi ke-1 tidak 
memenuhi kriteria maka 
dilanjutkan ke seleksi ke-2 

Karena seleksi ke-2 tidak 
memenuhi kriteria maka 
dilanjutkan ke seleksi ke-3 
dan kriteria terpenuhi 
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Contoh 2:  

 
 

  

  
Pembahasan : 

Operator pembanding pada seleksi ke-1 bernilai benar (true) atau kriteria terpenuhi. 

Oleh karena itu, program akan memilih kondisi ke 1 dan menghentikan proses seleksi. 

 

 Pada kedua contoh di atas, pernyataan if yang digunakan merupakan satu 

struktur bangunan if. Hal ini berarti bahwa apabila proses seleksi pada kriteria pertama 

telah terpenuhi (operator pembanding bernilai benar/true) maka proses seleksi pada 

kriteri-kriteria berikut akan dihentikan (proses seleksi telah selesai). 

 

Contoh 3: 

 

  

  
 

Hasil 

Hasil 

Melakukan 
seleksi ke-1 
dan kriteria 
terpenuhi 

Kriteri pada 
masing-
masing 
pernyataan if 
terpenuhi 
atau bernilai 
benar (true) 
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Pembahasan : 

Pada contoh 3 di atas, terdapat 3 pernyataan if dengan struktur bangunan yang berdiri 

sendiri-sendiri, sehingga proses seleksi akan terjadi pada setiap pernyataan if atau 

terjadi 3x proses seleksi. 

 

 

3.4 Pernyataan switch 

 Cara lain untuk membuat cabang seleksi adalah dengan menggunakan 

pernyataan switch. Pernyataan switch mengkonstruksikan cabang seleksi untuk 

beberapa kondisi dengan beberapa kriteria. Berbeda dengan pernyataan if, pernyataan 

switch hanya menggunakan operator pembanding sama dengan (==) saja dan tidak 

dapat menggunakan operator logika. Sintaks atau bentuk penulisan pernyataan switch 

adalah sebagai berikut : 

 
 switch(switch_expression){ 
  case case_selector1: 
   statement1; 
   statement2; kondisi ke-1 

   ...;  
   break; menghentikan proses seleksi/keluar dari switch 

  case case_selector2: 
   statement3; 
   statement4; kondisi ke-2 
   . . . ; 
   break; 
  case case_selector-n 
   statemen-n;  
   …..; 
   break; 
  default: memilih kondisi secara otomatis apabila kriteria sebelumnya tidak  

   statement1;  terpenuhi 
   statement2;  
   . . . ; 
   break; 
 } 

 
Contoh : 
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3.5 Penseleksian Bersarang 

 Penseleksian bersarang merupakan proses seleksi suatu kondisi yang berlapis 

atau penseleksian didalam penseleksian. Untuk membuat penseleksian bersarang 

dapat menggunakan pernyataan seleksi yang sejenis (if didalam if atau switch didalam 

switch) atau kombinasi diantara keduanya (if didalam switch atau sebaliknya). 

 

Contoh 1 : 

Konversi nilai akhir menjadi nilai huruf dengan ketentuan sebagai berikut : 

 

Nilai Akhir Nilai Huruf 

80 100 A 

65 79 B 

55 64 C 

45 54 D 

0 44 E 

 

dapat disajikan dalam kode program sebagai berikut ini :  

Hasil 
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`  

 

 
Pembahasan : 

Contoh di atas menggunakan if bersarang (nested if) yaitu if didalam if. Seleksi variabel          

NA = 70 memenuhi kriteria if yang kedua yaitu else if(NA>=65) dan juga 

memenuhi kriteria if yang ada didalamnya yaitu if(NA<=79) sehingga nilai huruf yang 

didapat adalah ‘B’. Oleh karena itu, untuk mendapatkan nilai huruf maka kedua 

kriterianya harus terpenuhi atau bernilai benar (true). 

 

Kode program di atas dapat disederhanakan menggunakan operator logika and seperti 

berikut ini. 

Hasil 

if bersarang (nested if) 

Kriteria ke-1 

Kriteria ke-2 

Kriteria ke-3 

Kriteria ke-4 

Kriteria ke-5 
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Pembahasan : 

 Kode program ini menggunakan operator pembanding dan operator logika ‘and’ 
(&&) secara bersamaan. Nilai variabel NA = 70, sesuai dengan kriteria kedua karena 

memenuhi persyaratan operator ‘and‘ (&&) (NA>=65 && NA<=79) dimana nilai operan 

kiri bernilai bernilai true (70>=65 → true) dan nilai operan kanan bernilai true 

(70<=79 → true). 

  

 

3.6 Latihan 

3.6.1 Aplikasi Warna 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’ dengan langkah-

langkah seperti pada percobaan modul 1 (New Package). Beri nama paket 

dengan ‘Modul3’. 
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2. Tambahkan ‘JFrame Form’ dalam paket ‘Modul3’. Beri nama JFrame Form 
dengan ‘Warna’. 

 
 

3. Masukkan komponen Panel dari jendela palette Swing Containers kedalam 

form.  
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Kemudian ubah posisi dan ukurannya menutupi seluruh form. 

 

4. Masukkan komponen Label, Radio Button, Button Group, Combo Box, dan 

Button pada palette Swing Controls kedalam komponen Panel sebelumnya 

seperti berikut ini : 

 
 

Khusus untuk komponen Button Group tidak tampak pada JFrameForm namun 

dapat dilihat pada jendela Navigator. Komponen Button Group digunakan untuk 

mengelompokkan komponen Radio Button agar hanya dapat dipilih salah 

satunya saja. 
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Catatan! 

✓ Komponen ‘Combo Box’ merupakan komponen entri data yang 

digunakan untuk memberikan/memasukkan nilai/data dalam bentuk 

pilihan-pilihan. Komponen ini mampu menyimpan lebih dari satu pilihan 

nilai/data dimana setiap nilai/data memiliki nomor urut atau indeks. 

Nilai/data yang tampil/tampak pada komponen Combo Box adalah 

nilai/data yang terpilih (selectedItem) dengan indeks sesuai dengan 

urutannya (selectedIndex). 

✓ Komponen ‘Radio Button’ merupakan komponen entri data yang 

digunakan untuk memberikan/memasukkan nilai/data dalam bentuk 

pilihan tunggal. Apabila menggunakan lebih dari satu komponen ini 

maka disarankan untuk menggunakan komponen ‘Button Group’. 
✓ Komponen ‘Button Group’ merupakan komponen untuk 

mengelompokkan komponen ‘Radio Button’ sesuai dengan kelompok 
data. Contoh kelompok ‘Jenis Kelamin’ menggunakan dua komponen 
‘Radio Button’ yaitu laki-laki dan perempuan. 

 

5. Ubah nama variabel dan nilai properti pada masing-masing komponen seperti 

berikut ini. 

 

Komponen Nama Variabel Properti 

buttonGroup1 grupWarna - 

jLabel1 - text = Bagian : 

jLabel2 - text = Warna : 

jButton1 btnUbah text = Ubah 

jRadioButton1 rbTeks text = Warna Teks 

  buttonGroup = grupWarna 

jRadioButton2 rbLatar text = Warna Latar 

  buttonGroup = grupWarna 

jComboBox1 cboWarna model = Merah, Hijau, Biru 

   

 

6. Untuk mengisi nilai/data pada komponen JComboBox, klik komponen 

JComboBox terlebih dahulu kemudian pada jendela properties, klik tombol  

pada properti ‘model’. 
 

7. Isi nilai/data yang dibutuhkan, kemudian klik tombol OK. 
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8. Klik kanan komponen btnUbah pada jendela navigator → Event → Action → 

klik ‘actionPerformed’. Ketikan kode program dibawah ini 
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9. Pastikan tidak ada tanda seru merah pada kode program Anda. Selanjutnya, 

jalankan program dengan cara klik kanan pada file program (frame) pilih Run 

File atau tekan Shift + F6 pada keyboard. 

 

 

3.6.2 Aplikasi Kasir 

 Berikut adalah percobaan membuat aplikasi kasir sederhana untuk menghitung 

tagihan transaksi. 

1. Tambahkan ‘JFrame Form’ dalam paket ‘Modul3’. Beri nama JFrame Form 

dengan ‘Kasir’. 

 
 

2. Desain form menggunakan komponen Dekstop Pane dari palette Swing 

Containers dan komponen Label, Text Field, Combo Box, serta Button dari 

jendela palette (Swing Controls) seperti berikut ini :  
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Komponen yang digunakan dapat dilihat pada jendela Navigator 

 
 

3. Ubah nama variabel dan nilai properti pada masing-masing komponen seperti 

berikut ini. 

Komponen Nama Variabel Properties 

Desktop Pane - background = Green 

jLabel1 - text = Nama Pembeli 

jLabel2 - text = Status 

jLabel3 - text = Jenis Barang 
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jLabel4 - text = Harga 

jLabel5 - text = Jumlah 

jLabel6 - text = Diskon 

jLabel7 - text = Total Bayar 

jLabel8 - text = Keterangan : Member Diskon 5% 

jButton1 btnbayar text = Bayar 

jTextField1 txtnama text = <kosongkan> 

jTextField2 txtharga text = <kosongkan> 

  editable = False 

jTextField3 txtjumlah text = <kosongkan> 

jTextField4 txtdiskon text = <kosongkan> 

  editable = False 

jTextField5 txttotal text = <kosongkan> 

  editable = False 

jComboBox1 cbostatus model = Umum, Member 

jComboBox2 cbojenis model = Pilih, iPad, iPhone, iPod 

 

4. Ubah susunan masing-masing komponen seperti berikut ini. 

 
 

5. Klik kanan komponen cbojenis pada jendela navigator → Event → Action → 

klik ‘actionPerformed’. Ketikan kode program dibawah ini 
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6. Klik kanan komponen btnbayar pada jendela navigator → Event → Action → 

klik ‘actionPerformed’. Ketikan kode program dibawah ini 

 
 

7. Perhatikan penulisan source code huruf besar & huruf kecil berpengaruh (Case 

Sensitif). 

 

8. Pastikan tidak ada tanda seru merah pada kode program Anda. Selanjutnya, 

jalankan program dengan cara klik kanan pada file program (frame) pilih Run 

File atau tekan Shift + F6 pada keyboard. 
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MODUL 4 

STRUKTUR PERULANGAN 

4.  

 

MODUL 4 

STRUKTUR PERULANGAN 

 

Topik Pembahasan : 

• Struktur for 

• Struktur while 

• Struktur do…while 

• Perulangan Bersarang 

• Latihan  
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 Perulangan (looping) merupakan proses eksekusi blok kode program secara 

berulang-ulang (putaran) sampai batas tertentu (kriteria terpenuhi). Secara umum, 

perulangan menggunakan operator pembanding sebagai suatu kriteria untuk 

menentukan batas akhir sehingga dalam proses kerja perulangan seolah-olah terdapat 

atau menggunakan pernyataan if. Dalam modul ini, struktur perulangan yang dibahas 

adalah for, do…while, dan while.  

 

4.1 Struktur for 

 Struktur perulangan for memiliki 3 parameter. Sintaks atau bentuk penulisan 

struktur perulangan for adalah sebagai berikut : 

 
for(inisialisasi; kriteria_kondisi; proses_iterasi){ 
 statement1; 
 statement2; 
  statement-n; 
}  

 
Keterangan : 

• Parameter 1 adalah inisialisasi yaitu menentukan nilai awal untuk memenuhi 

kriteria yang digunakan. 

• Parameter 2 adalah kriteria_kondisi yaitu persyaratan yang harus terpenuhi 

(bernilai benar) agar proses perulangan dapat berjalan. Secara umum, 

parameter ini menggunakan operator pembanding. 

• Parameter 3 adalah proses_iterasi yaitu proses perulangan nilai (berupa angka). 

Secara umum, parameter ini menggunakan operator increment/decrement atau 

operator penugasan (assignment). 

  

Contoh : 

 

 

 
Pembahasan : 

Tahapan proses eksekusi kode program pada contoh perulangan for di atas, 

digambarkan pada ilustrasi di bawah ini. 
 

Hasil 
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 1  n = 1; 

 2  if (n<=10){ 

 3   System.out.print(n + “ “); 
 4   n++; 

   } 

 

• Tahap 1 merupakan parameter pertama yaitu menentukan nilai awal dari 

variabel n. 

• Tahap 2 merupakan parameter kedua yaitu proses seleksi dengan kriteria/syarat 

n<=10 (operator pembanding lebih kecil sama dengan). Apabila kriteria 

terpenuhi atau bernilai benar (true) maka eksekusi kode program akan 

dilanjutkan ke tahap 3. 

• Tahap 3 merupakan pernyataan atau kode program didalam perulangan for. 

• Tahap 4 merupakan parameter ketiga yaitu proses iterasi dengan operator 

increment. 

• Selanjutnya proses eksekusi akan diulang kembali dari tahap 2 dan dilanjutkan 

lagi ke tahap-tahap berikut. 

• Putaran eksekusi dalam perulangan tetap terjadi selama kriteria terpenuhi atau 

bernilai benar (true). 

• Apabila kriteria tidak terpenuhi maka eksekusi perulangan akan berhenti 

(selesai). 

 

 

4.2 Struktur while 

 Perulangan ini akan bekerja selama (while) kriteria kondisi terpenuhi atau 

bernilai benar (true). Berikut adalah sintaks atau bentuk penulisan perulangan while. 

 
while(kriteria_kondisi) { 
 statement1; 
 statement2; 
  statement-n; 
 proses_iterasi; 
}  

 

Contoh : 
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Pembahasan : 

Tahapan proses eksekusi kode program pada contoh perulangan while di atas, 

digambarkan pada ilustrasi di bawah ini. 

 
 1  m = 1; 

 2  if (m<=10){ 

 3   System.out.print(m + “ “); 
 4   m+=2; 

   } 

 

• Tahap 1, menentukan nilai awal dari variabel m. 

• Tahap 2, melakukan proses seleksi dengan kriteria/syarat m<=10 (operator 

pembanding lebih kecil sama dengan). Apabila kriteria terpenuhi atau bernilai 

benar (true) maka eksekusi kode program akan dilanjutkan ke tahap 3. 

• Tahap 3, menjalankan eksekusi pernyataan atau blok kode program didalam 

perulangan while. 

• Tahap 4, melakukan proses iterasi dengan operator penugasan (assignment). 

• Selanjutnya proses eksekusi akan diulang kembali dari tahap 2 dan dilanjutkan 

lagi ke tahap-tahap berikut. 

• Putaran eksekusi dalam perulangan tetap terjadi selama kriteria terpenuhi atau 

bernilai benar (true). 

• Apabila kriteria tidak terpenuhi maka eksekusi perulangan akan berhenti 

(selesai). 

 

Peringatan 

Perulangan while tanpa menggunakan proses iterasi mengakibatkan 

proses eksekusi kode program terjadi tanpa akhir karena kriteria kondisi 

akan tetap terpenuhi.  

 

 

4.3 Struktur do…while 

 Seperti halnya perulangan while, perulangan ini juga akan bekerja selama 

(while) kriteria kondisi terpenuhi atau bernilai benar (true). Namun, berbeda dengan 2 

struktur perulangan sebelumnya (for dan while), do…while akan melakukan eksekusi 

Hasil 
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pernyataan terlebih dahulu (do) sebelum melakukan seleksi kriterianya (while). Berikut 

adalah sintaks atau bentuk penulisan perulangan do…while 

 
do{ 
 statement1; 
 statement2; 
  statement-n; 
 proses_iterasi 
}while(kriteria_kondisi); 

 
Contoh : 

 
 

 

 
Pembahasan : 

Tahapan proses eksekusi kode program pada contoh perulangan do…while di atas, 

digambarkan pada ilustrasi di bawah ini. 

 
 1  p = 2; 

 2  System.out.print(p + “ “); 
 3  p = p + 2; 

 4  if (p<=10){ 

 5   <kriteria terpenuhi> 

 6  } else { 

    <kriteria tidak terpenuhi>  

   } 

 

• Tahap 1, menentukan nilai awal dari variabel p. 

• Tahap 2, menjalankan eksekusi pernyataan atau blok kode program didalam 

perulangan do…while. 

• Tahap 3, melakukan proses iterasi dengan operator penugasan (assignment). 

• Tahap 4, melakukan proses seleksi dengan kriteria/syarat p<=10 (operator 

pembanding lebih kecil sama dengan). 

Hasil 
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• Apabila kriteria terpenuhi atau bernilai benar (true) maka eksekusi kode program 

akan diulang kembali dari tahap 2 dan dilanjutkan lagi ke tahap-tahap berikut.  

• Putaran eksekusi dalam perulangan tetap terjadi selama kriteria terpenuhi atau 

bernilai benar (true). 

• Apabila kriteria tidak terpenuhi maka eksekusi perulangan akan berhenti 

(selesai). 

 

Peringatan 

Perulangan do…while tanpa menggunakan proses iterasi 

mengakibatkan proses eksekusi kode program terjadi tanpa akhir karena 

kriteria kondisi akan tetap terpenuhi. 

 

 

4.4 Perulangan Bersarang 

 Perulangan bersarang adalah penggunaan perulangan didalam perulangan. 

Perulangan yang digunakan dapat berupa perulangan sejenis atau kombinasi jenis 

perulangan satu dengan jenis perulangan yang lainnya. 

 

Contoh : 

 
 

 

 
Pembahasan : 

Contoh di atas menggunakan 2 buah jenis perulangan yang berbeda yaitu perulangan 

while didalam perulangan for. Dalam putaran perulangan for yang pertama, perulangan 

while akan menyelesaikan putaran proses eksekusinya sebelum melanjutkan ke 

putaran perulangan for berikutnya.  

Hasil 
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4.5 Latihan 

Berikut adalah percobaan membuat aplikasi sederhana untuk menampilkan daftar 

perkalian menggunakan perulangan. 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’ dengan langkah-

langkah seperti pada percobaan modul 1 (New Package). Beri nama paket 

dengan ‘Modul4’. 

 
 

2. Tambahkan ‘JFrame Form’ dengan langkah-langkah seperti pada percobaan 

modul 1 (menambah frame form). Beri nama JFrame Form dengan ‘Kasir’. 

 
 

3. Desain form menggunakan komponen Button dari jendela palette seperti 

berikut ini : 
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4. Ubah nama variabel dan nilai properti pada masing-masing komponen seperti 

berikut ini. 

Komponen Nama Variabel Properti 

jButton1 btnTambah text = Penjumlahan 

jButton2 btnKurang text = Pengurangan 

jButton3 btnKali text = Perkalian 

 

sehingga menjadi  

     
 

5. Klik kanan komponen btnTambah pada jendela navigator → Event → Action 

→ klik ‘actionPerformed’. Ketikan kode program dibawah ini 
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6. Klik kanan komponen btnKurang pada jendela navigator → Event → Action 

→ klik ‘actionPerformed’. Ketikan kode program dibawah ini 

 
 

7. Klik kanan komponen btnKali pada jendela navigator → Event → Action → 

klik ‘actionPerformed’. Ketikan kode program dibawah ini 
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8. Pastikan tidak ada tanda seru merah pada kode program Anda. Selanjutnya, 

jalankan program dengan cara klik kanan pada file program (frame) pilih Run 

File atau tekan Shift + F6 pada keyboard. 
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MODUL 5 

ARRAY 

5.  

 

MODUL 5 

ARRAY 

 

Pokok Pembahasan : 

• Array Satu Dimensi 

• Array Multi Dimensi 

• Perulangan Array 

• Class Array 

• Latihan 
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 Array atau disebut juga larik merupakan struktur kumpulan variabel secara 

berurutan yang menyimpan data/nilai (isi variabel) bertipe sama. Satu variabel dalam 

array disebut sebagai elemen dan urutan akses elemen disebut indeks. Indeks elemen 

dalam array selalu dimulai dari angka 0.  Dalam pemrograman Java, deklarasi array 

ditandai dengan kurung siku [ ].  

 

5.1 Array Satu Dimensi 

 Array satu dimensi adalah array atau larik dengan satu ruang penyimpanan. 

Untuk lebih jelas mengenai perbedaan variabel biasa dengan array satu dimensi dapat 

dilihat pada gambar di bawah ini.  

 

  
 

Untuk menyimpan 5 nilai yang berbeda dibutuhkan 5 variabel biasa untuk masing-

masing nilai tersebut. Dengan array, kelima nilai tersebut dapat disimpan dalam 1 

variabel dengan ruang penyimpanan yang berbeda sehingga seolah-olah hanya 

menggunakan 1 variabel saja. Untuk mengakses ruang penyimpanannya, serta urutan 

akses (indeks) setelah nama variabel. 

 
 

Berikut bentuk deklarasi array satu dimensi. 

 
  deklarasi inisialisasi 

 

Bentuk 1 :  tipeData[] namaArray = {data-1, data-2, data-n}; 

                             
    Jumlah dimensi     elemen ke-0      elemen ke-1   elemen ke-(n-1) 
 
 

nilai[0] = 80,5

nilai[1] = 65

nilai[2] = 50

nilai[3] = 78,9

nilai[4] = 92,5

→ urutan akses  

      (indeks) 
0 1 2 3 4

nilai = 80,5 65 50 78,9 92,5



 

71 

Bentuk 2 : 
   Jumlah dimensi          keyword 
                
  tipeData[] namaArray = new tipeData[n]; → deklarasi 

  namaArray[0] = data-1; → elemen ke-0 

inisialisasi namaArray[1] = data-2; → elemen ke-1 

  namaArray[n-1] = data-n; → elemen ke-(n-1) 

 

Keterangan : 

• tipeData disesuaikan dengan jenis data/nilai yang akan disimpan dalam 

array. 

• namaArray adalah nama variabel. 

• n adalah jumlah/banyaknya elemen array. 

 

Pada bentuk 1, data/nilai ditentukan secara langsung (inisialisasi) setelah deklarasi 

array. Data/nilai satu dengan yang lainnya dipisahkan dengan simbol koma (,). 

Banyaknya data/nilai yang di-inisialisasi-kan sama dengan banyaknya elemen array 

yang akan terbentuk. Indeks elemennya dimulai dari angka 0 sampai dengan n-1 

 

Pada bentuk 2, inisialisasi dilakukan setelah proses deklarasi array. Banyaknya 

data/nilai yang di-inisialisasikan tergantung kepada nilai n pada deklarasi array dengan 

indeks elemennya dimulai dari angka 0 sampai dengan n-1. 

 

Contoh 1: 

Berikut adalah contoh array dimensi satu (bentuk 1) : 

 

 

 

Hasil 
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Pembahasan : 

Banyaknya data yang di-inisialisasi-kan berjumlah 5 (n=5) yaitu {80.5, 65, 50, 78.9, 

92.5} dengan urutan akses elemen dari 0 sampai dengan n-1. 

 

 

5.2 Array Multi Dimensi 

 Array multi dimensi memiliki lebih dari satu dimensi atau ruang penyimpanan 

data/nilai. Pada array dua dimensi, ruang penyimpanan berupa matriks atau tabel. 

Berikut bentuk deklarasi array multi dimensi. 

 

Bentuk 1 : 

 
         deklarasi                                                      inisialisasi 

 
tipeData[][] namaArray = { {data-1, data-n},   → elemen x0 

         {data-1, data-n}, → elemen x1 

         {data-1, data-n} → elemen x2 
      }; 

            
 jumlah dimensi       elemen y0  elemen y1   
  
 
Bentuk 2 :  
  
  jumlah dimensi    keyword  ukuran dimensi 
        
tipeData[][] namaArray = new tipeData[x][y]; → deklarasi 

         namaArray[0][0]  = data-1; → elemen 0,0 

      namaArray[0][y-1] = data-n; → elemen 0,y-1 

inisialisasi 

   namaArray[x-1][0]  = data-1; → elemen x-1,0 

   namaArray[x-1][y-1] = data-n; → elemen x-1, y-1 

    
Keterangan : 

• Jumlah kurung siku menyatakan jumlah dimensi yang digunakan dimana 

([][]) berarti menggunakan array 2 dimensi.  

• Pada bentuk 2, [x][y] menyatakan ukuran dimensi yang digunakan. 
 

Contoh 1: 

Berikut adalah contoh array multi dimensi (bentuk 1) : 
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Pembahasan : 

Contoh di atas menggunakan array 2 dimensi dengan ukuran 3x2 yaitu 3 baris (0-2) 

dan 2 kolom (0-1). Array 2 dimensi ditandai dengan kurung siku sebanyak 2 kali. 

Karakter ‘\t’ akan mencetak ‘tab’ sebanyak 1x. 
 

 

5.3 Perulangan Array 

  Perulangan pada array menggunakan pernyataan for dan hanya berlaku untuk 

array satu dimensi. Salah satu pernyataan for yang dapat digunakan pada array adalah 

for each dimana akan mengiterasi dan menyimpan nilai setiap elemen array dalam 

variabel tunggal. Berikut sintaks atau bentuk penulisan pernyataan for each pada array. 

 
for(tipeData namaVariabel : namaArray){ 

 kode_program1;  

 kode_program2;  blok kode program 

 …; 
} 

 

Keterangan : 

• tipeData yang digunakan harus sama dengan tipe pada array. 

  

Contoh 1 : 

Pada contoh array satu dimensi di atas, 

Hasil 
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dapat diubah menggunakan perulangan array menjadi : 

 
 

tetap dengan hasil eksekusi (run) yang sama.  

 
 

Contoh 2 : 

Berikut adalah contoh array dimensi satu (bentuk 2) : 
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Pembahasan : 

Fungsi length pada array menghasilkan nilai banyaknya array yang terbentuk 

sehingga dapat digunakan pada perulangan for sebagai batas akhir perulangan untuk 

mengakses setiap elemen pada array. 

 

Contoh 3: 

Berikut adalah contoh array multi dimensi (bentuk 2) dengan contoh kasus jadwal 

railink Medan – Kualanamu sesuai tabel di bawah ini. 

 

 
(sumber : https://www.railink.co.id/index.php/jadwal/en, diakses 1/12/2018) 

 

 

Hasil 
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Pembahasan : 

Contoh di atas menggunakan array 2 dimensi dengan ukuran 3x3 yaitu 3 baris (0-2) 

dan 3 kolom (0-2). Array 2 dimensi ditandai dengan kurung siku sebanyak 2 kali dan 

ukuran array ditandai dengan                                    . Karakter ‘\t’ akan mencetak ‘tab’ 
sebanyak 1x. 

Perintah                                  menghasilkan nilai banyaknya array pada ruang dimensi 

x dan perintah                                             menghasilkan nilai banyaknya array pada 

ruang dimensi y. 

 

 

5.4 Class Array Pada Java  

 Untuk melakukan operasi lebih lanjut pada array, pemrograman Java telah 

menyediakan class untuk membantu programer mengolah data/nilai pada array. 

 

Hasil 
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5.4.1 Class Arrays 

 Class Arrays merupakan turunan dari java.util.Arrays. Class Arrays 

melakukan operasi terhadap variabel array, yang berarti class ini tidak dapat digunakan 

tanpa adanya variabel array (baik array satu dimensi maupun array multidimensi). 

Dengan Class Arrays, programer dapat melakukan operasi terhadap variabel array 

seperti menyalin (copying), mengurutkan (sorting), mencari (searching) dan lain-lain. 

Sebelum menggunakan class arrays, terlebih dahulu programer harus menambahkan 

class tersebut melalui import (                                                  ). Berikut beberapa 

operasi (method) Class Arrays yang akan dibahas. 

• copyOf(arraySumber, ukuranArray) adalah fungsi untuk menyalin 

array sumber (baik struktur maupun isi) secara keseluruhan ke array tujuan. 

Contoh : 

 

    
 

copyOfRange(arraySumber, indeksAwal, indeksAkhir) sama 

seperti copyOf, namun dapat ditentukan/dikostumasi ukuran dan isi array 

sumber ke array tujuan. Contoh : 

 

  

• sort(arraySumber, indeksAwal, indeksAkhir) adalah metode 

untuk melakukan pengurutan pada seluruh elemen array. Parameter 

indeksAwal dan indeksAkhir bersifat opsional. Contoh : 

Hasil 

Hasil 
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untuk melakukan pengurutan pada elemen tertentu pada array, dapat 

menambahkan indeks awal dan indeks akhir dari elemen array yang ingin 

diurutkan pada pada parameter kedua dan ketiga. Contoh : 

 
 

• binarySearch(arraySumber, nilaiCari) adalah fungsi untuk 

melakukan pencarian biner berdasarkan nilai yang ada didalam array. Fungsi 

ini menghasilkan nilai bertipe int yang menyatakan indeks elemen. Apabila nilai 

yang dicari tidak ditemukan, fungsi akan menghasilkan nilai lebih kecil 0. 

Contoh : 

 

      
 

• equals(array1, array2) adalah fungsi untuk melakukan perbandingan 

terhadap seluruh nilai elemen array. Fungsi ini menghasilkan nilai bertipe 

boolean yang menyatakan true apabila seluruh nilai elemen sama dan 

false apabila salah satu nilai elemen tidak sama. Contoh : 

Hasil 

Hasil 
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• fill(arraySumber, nilaiBaru) merupakan metode (method) untuk 

mengisi nilai kedalam elemen array. Contoh 1: 

 

 
Terdapat 5 elemen dalam array ‘hasil’ yang telah memiliki nilai awal. Dengan 
method fill(hasil, 55) pada class Arrays, seluruh nilai pada setiap elemen array 

‘hasil’ diubah menjadi ‘55’. 
 

Contoh 2: 

 

      

Hasil 

Hasil 

Hasil 
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Untuk mengubah sebagian nilai elemen dalam array, tentukan parameter ke-

2 yaitu indeks awal dan parameter ke3 yaitu banyaknya elemen array. 

 

5.4.2 Class ArrayList  

 Class ArrayList yang dibahas pada modul ini hanya untuk array satu dimensi. 

Pengolahan data/nilai array menggunakan Class ArrayList menjadi lebih dinamis yang 

berarti bahwa pengolahan data/nilai tidak hanya dilakukan melalui rancangan kode 

program (sebelum program dijalankan/running) namun juga dapat dilakukan pada saat 

program dijalankan/running. Beberapa perbedaan Class Arrays dan Class ArrayList 

antara lain adalah : 

1. Arrays tidak dideklarasikan sedangkan ArrayList harus dideklarasikan menjadi 

sebuah objek.  

2. Arrays mengolah nilai elemen array dari variabel array sedangkan ArrayList 

dapat mengolah nilai elemen array secara langsung. 

3. Data/nilai pada ArrayList bukan merupakan data/nilai bertipe primitif melainkan 

objek sehingga ArrayList dapat menampung data/nilai dengan berbagai tipe 

yang berbeda-beda. 

 

 Class ArrayList juga merupakan turunan dari java.util yaitu 

java.util.ArrayList. Oleh karena itu, sebelum menggunakan ArrayList terlebih 

dahulu programer harus menambahkan class tersebut melalui import                      

(                                                 ). Adapun sintaks atau bentuk deklarasi objek Class 

ArrayList adalah sebagai berikut. 

 
ArrayList namaObjek = new ArrayList(); 

 

Untuk lebih memahami pengolahan data/nilai array menggunakan Class ArrayList, 

berikut akan dijelaskan beberapa operasi (method) pada Class ArrayList. 

• add(indeks, nilai) merupakan metode (method) untuk menambah elemen 

array dan nilainya. Parameter indeks bersifat opsional. Contoh : 

  

→ tipe String 

→ tipe char 

→ tipe double 

→ tipe boolean 
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Keterangan : 

Jenis data/nilai yang ditambahkan (add) pada objek ArrayList berbeda-beda. 

Perintah                                      berarti menambah nilai ‘2017’ pada indeks ke-

2. 

 

• set(indeks, nilai) merupakan metode (method) untuk merubah nilai 

elemen pada indeks tertentu. Contoh  : 

 

 
Keterangan : 

Perintah                                       merubah data/nilai pada indeks elemen ke-3 

dengan nilai ‘3.33’. 
 

• remove(indeks) merupakan metode (method) untuk menghapus elemen 

pada indeks tertentu. Contoh  : 

 

Hasil 

Hasil 
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Keterangan : 

Perintah                                menghapus elemen pada indeks ke-1. 

 

• clear() merupakan metode (method) untuk menghapus seluruh elemen pada 

objek ArrayList. Contoh : 

 

 
 

• size() merupakan metode (method) yang menghasilkan jumlah/banyak 

elemen pada objek ArrayList. Contoh : 

 

Hasil 

Hasil 
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• get(index) merupakan metode (method) untuk mendapatkan data/nilai dari 

elemen ArrayList berdasarkan nomor indeks. Contoh : 

 

     
 

• indexOf(arrayValue) merupakan metode (method) untuk mendapatkan 

nomor indeks dari elemen ArrayList berdasarkan data/nilai. Contoh : 

 

   
 

• contains(arrayValue) merupakan metode (method) untuk memeriksa 

keberadaan data/nilai tertentu (arrayValue) dalam objek ArrayList. Method ini 

akan menghasilkan nilai true jika ditemukan dan menghasilkan nilai false jika 

data/nilai tidak ditemukan. Contoh : 

Hasil 

Hasil 

Hasil 
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• isEmpty() merupakan metode (method) untuk memeriksa ada atau tidaknya 

data/nilai dalam objek ArrayList. Method ini akan menghasilkan nilai true jika 

tidak ada data/nilai dan menghasilkan nilai false jika ada data/nilai. 

 

 

5.5 Latihan 

 Berikut adalah percobaan membuat aplikasi sederhana untuk menampilkan 

daftar perkalian menggunakan perulangan. 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’ dengan langkah-

langkah seperti pada percobaan modul 1 (New Package). Beri nama paket 

dengan ‘Modul5’. 

 
 

Hasil 
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2. Tambahkan ‘JFrame Form’ dengan langkah-langkah seperti pada percobaan 

modul 1 (menambah frame form) pada paket ‘Modul5’. Beri nama JFrame 

Form dengan ‘Kasir2’. 

 
 

3. Masukkan komponen ‘Panel’ dari palette swing container kedalam form dan 
atur ukurannya sesuai dengan ukuran form. 

 

4. Masukkan komponen ‘Label’, ‘Text Field’, ‘Combo Box’, ‘Button’ dan ‘Table’ 
dari palette swing controls kedalam komponen ‘Panel’. Susun posisi masing-

masing komponen seperti pada gambar di bawah ini. 

 
Catatan! 

Komponen ‘Table’ merupakan komponen yang digunakan untuk menampilkan 

data dari objek yang lain. 

 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 
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5. Untuk mengubah nama-nama kolom pada komponen jTable1, klik kanan pada 

komponen ‘Tabel’ (atau pada jendela navigator jTable1) → Properties. Klik 

tombol  pada properti model. Double click pada kolom ‘Title’ dan ubah nama 

kolom sesuai gambar berikut ini. Klik tombol ‘OK’. 

 
 

6. Ubah nama variabel dari beberapa komponen sesuai dengan nomor 

komponen pada poin 4 di atas. 

 

→ 1 
→ 2 
→ 3 
→ 4 
→ 5 

→ 6 
→ 7 
→ 8 
→ 9 
→ 10 
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7. Klik kanan pada ‘cboMakan’ → Properties. Klik tombol  pada model 

kemudian isi data sesuai gambar berikut ini. 

 
 

8. Klik kanan pada ‘cboMinum’ → Properties. Klik tombol  pada model 

kemudian isi data sesuai gambar berikut ini. 

 
 

→ 11 
→ 12 
→ 13 
→ 14 
→ 15 
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9. Ubah properti ‘editable’ menjadi false pada komponen ‘txtHargaMakan’, 
‘txtSubTotalMakan’, ‘txtHargaMinum’, ‘txtSubTotalMinum’, ‘txtTotal’, ‘txtPajak’, 
dan ‘txtBayar’. 
 

10. Klik tab ‘Source’ kemudian ketikkan kode program berikut ini untuk 

memasukkan (import) paket Java yang dibutuhkan. 

 
 

11. Ketikkan deklarasi objek ArrayList seperti di bawah ini agar dapat digunakan 

didalam kelas. 

 
 

12. Ketikkan method ‘cekKosong’ berikut ini. 

 
Method ‘cekKosong’ digunakan untuk memeriksa komponen entri data yang 
masih kosong. Apabila terdapat komponen entri data yang masih kosong maka 

akan menampilkan pesan peringatan. 
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13. Ketikkan method ‘cekDataTabel’ berikut ini. 

 
Method ‘cekDataTabel’ digunakan untuk memeriksa keberadaan nilai/data 

yang sudah ada pada objek ArrayList. Apabila terdapat nilai/data yang sudah 

ada didalam objek ArrayList maka akan menampilkan pesan peringatan dan 

nilai/data tersebut tidak ditambahkan kedalam objek ArrayList. 

 

14. Ketikkan method ‘setHargaMakanan’ berikut ini. 

 

 
Method ‘setHargaMakanan’ digunakan untuk menentukan harga makanan 

yang dipilih dari komponen ‘cboMakan’ berdasarkan nomor urut (indeks) 
nilai/data terpilih. Harga akan ditampilkan pada komponen ‘txtHargaMakan’ 
dan menghitung harga sub total makanan. 
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15. Ketikkan method ‘setHargaMinuman’ berikut ini. 

 

 
Method ‘setHargaMinuman’ digunakan untuk menentukan harga minuman 

yang dipilih dari komponen ‘cboMinum’. Harga akan ditampilkan pada 
komponen ‘txtHargaMinum’ dan menghitung harga sub total minuman. 

 

16. Ketikkan method ‘setTabel’ berikut ini. 

 

 
Method ‘setTabel’ digunakan untuk menampilkan seluruh nilai/data dari objek 

ArrayList melalui komponen ‘Table’, menghitung nilai pajak yang dikenakan, 
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menghitung seluruh biaya yang harus dibayarkan, dan menampilkannya pada 

komponen ‘txtTotal’, ‘txtPajak’, dan ‘txtBayar’. 
 

17. Klik kanan pada komponen ‘btnTbhMakan’ → Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
Komponen Button ‘btnTbhMakan’ akan menjalankan proses yang berkenaan 
dengan menu makanan antara lain menambah item makanan terpilih kedalam 

tabel, menghitung nilai sub total, total, pajak, dan nilai biaya yang harus 

dibayarkan. 

 

18. Klik kanan pada komponen ‘btnTbhMinum’ → Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
Komponen Button ‘btnTbhMinum’ akan menjalankan proses yang berkenaan 

dengan menu minuman antara lain menambah item minuman terpilih kedalam 
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tabel, menghitung nilai sub total, total, pajak, dan nilai biaya yang harus 

dibayarkan. 

 

19. Klik kanan pada komponen ‘btnBayar’ → Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

20. Klik kanan pada komponen ‘cboMakan’ → Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

21. Klik kanan pada komponen ‘cboMinum’ → Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

22. Klik kanan pada komponen ‘txtQtyMakan’ → Events → Key → keyTyped. 

Ketikkan kode program berikut ini. 

 
Perintah ini digunakan hanya untuk menerima nilai masukan dari komponen 

txtQtyMakan berupa karakter angka saja. 
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23. Klik kanan pada komponen ‘txtQtyMinum’ → Events → Key → keyTyped. 

Ketikkan kode program berikut ini. 

 
 

24. Pastikan tidak ada tanda seru merah pada kode program Anda. Selanjutnya, 

jalankan program dengan cara klik kanan pada file program (frame) pilih Run 

File atau tekan Shift + F6 pada keyboard. 
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MODUL 6 

STRUKTUR METODE (METHOD) 

6.  

 

MODUL 6 

STRUKTUR METODE (METHOD) 

 

Pokok Pembahasan : 

• Metode Tanpa Nilai 

• Metode Dengan Nilai 

• Modifier 

• Latihan 
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 Metode (method) merupakan sekumpulan atau blok kode program yang menjadi 

sub  kode program. Kode program pada metode ditulis seluruhnya (modifier, tipe nilai 

kembalian, nama, parameter, dan isi metode atau blok kode program) oleh programer 

diluar dari kode program utama. Oleh karena itu untuk menjalankan sebuah metode, 

nama metode harus ditulis didalam kode program utamanya. Melalui penggunaan 

metode, programer dapat mengurangi penulisan kode program yang sama atau 

berulang.  

 

6.1 Metode Tanpa Nilai 

 Metode (method) tanpa nilai berarti tidak dapat menampung nilai kembalian 

(return value) dari metode itu sendiri. Metode tanpa nilai juga disebut sebagai prosedur 

(procedure). Sintaks atau bentuk penulisan metode tanpa nilai pada Java adalah 

sebagai berikut : 

 
modifier void methodName(parameter){ 
  kode_program1; 
 kode_program2;   blok kode program (isi metode) 
 kode_program3; 
} 

 

Keterangan : 

• void merupakan ciri utama dari metode tanpa nilai yang harus ditulis sebelum 

nama metode. 

• parameter berupa variabel untuk menampung nilai dari luar metode yang 

dapat digunakan didalam metode. Penggunaan paramater bersifat opsional. 

 

 

6.2 Metode Dengan Nilai 

 Metode (method) dengan nilai adalah metode yang dapat menampung nilai 

kembalian (return value) dari metode itu sendiri. Oleh karena itu, metode ini harus 

menggunakan tipe nilai (tipe data) kembaliannya yaitu tipe data primitif. Metode ini juga 

disebut sebagai fungsi (function). Sintaks atau bentuk penulisan metode dengan nilai 

pada Java adalah sebagai berikut : 

 
modifier returnValueTipe methodName(parameter){ 
  kode_program1; 
 kode_program2;   blok kode program (isi metode) 
 kode_program3; 
 return value; 
} 
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Keterangan : 

• returnValueTipe merupakan tipe data primitif yang harus ditulis sebelum 

nama metode. 

• return merupakan pernyataan yang wajib digunakan untuk mengembalikan 

nilai/data dari metode. Pernyataan return diikuti dengan nilai/data sesuai 

dengan returnValueTipe. 

• parameter berupa variabel untuk menampung nilai dari luar metode yang 

dapat digunakan didalam metode. Penggunaan paramater bersifat opsional. 

 

Contoh metode tanpa nilai - I (tidak menggunakan parameter) : 

 

 

 

 

  

  
 

 

 

Hasil 

nama metode modifier 

metode 
tanpa nilai 

Kode 
program 
utama 
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Pembahasan : 

Pada kode program utama, hanya terdapat perintah untuk mencetak kalimat “Aplikasi 
Menghitung” (System.out.println("Aplikasi Menghitung");) sehingga 

metode ‘hitung()’ tidak dijalankan/dieksekusi. Untuk mengeksekusi metode, tulis nama 

metode tersebut pada kode program utama. 

 

  

  
 

 

Contoh metode tanpa nilai - II (menggunakan parameter): 

 

 

 

  

Hasil 

memanggil metode dengan 3 nilai parameter 

nama metode modifier 

Kode 
program 
utama 

metode 
tanpa nilai 

Output dari metode 

Output dari kode program utama 

Memanggil metode hitung() 
pada kode program utama 

parameter 
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Pembahasan : 

Metode ‘hitung’ di atas menggunakan 3 parameter (

) dengan tipe data float dan char. Tipe data 

yang digunakan pada parameter disesuaikan dengan nilai/data yang akan 

diberikan/dimasukkan. 

 

 
Nilai/data yang diberikan/dimasukkan kedalam metode ditentukan pada saat 

pemanggilan metode. 

  
 

 
Nilai/data akan ditampung oleh masing-masing parameter. Ketiga parameter tersebut 

juga dapat digunakan didalam metode itu sendiri sebagai pengolahan nilai/data. 

Contoh metode dengan nilai :  

 

 

 

Hasil 

returnValueType 
nama 

metode modifier 

metode 
dengan 

nilai 

parameter 
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Pembahasan : 

Ciri metode dengan nilai adalah penggunaan tipe nilai kembalian sebelum nama 

metode                                                                             (

) dan 

pernyataan return ( ). 

Metode dengan nilai dapat dipanggil didalam variabel. Nilai kembalian dari metode 

akan disimpan pada variabel ( ) yang 

memanggil metode tersebut. Oleh karena itu, tipe data variabel harus sesuai dengan 

tipe nilai kembalian. 

Selain itu, metode dengan nilai juga dapat dipanggil didalam suatu perintah                      

( ) sehingga nilai 

kembali dari metode akan langsung dieksekusi oleh perintah tersebut. 

 

 

6.3 Modifier 

 Modifier pada pemrograman Java terbagi menjadi dua kriteria yaitu access 

modifier dan non-access modifier. Modifier merupakan pengaturan level akses untuk 

membatasi ruang lingkup penggunaan dari variabel, method, data member, class, atau 

konstruktor. Keyword yang termasuk non-access modifier dapat dilihat pada tabel 6.1. 

 

Tabel 6.1 Non-Access Modifier 

keyword keterangan 

static Modifier static dapat diterapkan pada variabel atau method.  
Pada variabel, modifier ini akan mempertahankan nilai yang 
ada (nilai terakhir) pada variabel atau method. 

 

Hasil 

kode 
program 
utama 
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 Pada method, modifier ini akan mempertahankan method yang 
sudah ada dalam setiap instance sebuah class. 

final Keyword final dapat digunakan pada variabel, method, atau 
class. Pada variabel, modifier ini membuat nilai tetap konstan. 
Pada method, modifier ini mencegah terjadinya override atau 
modifikasi dalam sebuah subclass. 

abstract Modifier abstract dapat digunakan pada method dan class. Jika 
class berisi method abstaract maka kelas juga harus 
dideklarasikan sebagai abstract. 

synchronized Java menyediakan cara untuk membuat thread dan 
mensinkronkan tugas (thread) menggunakan blok yang 
tersinkronisasi. Modifier synchronized biasa digunakan pada 
program multi-threading. Modifier ini mensinkronkan blok 
thread pada satu waktu. 

transient Modifier ini digunakan pada serialisasi. Variabel yang 
menggunakan keyword transient dapat mengabaikan nilai asli 
dari variabel dan menyimpan nilai default dari tipe data variabel 
tersebut. 

volatile Modifier volatile digunakan untuk mengizinkan JVM 
mengetahui thread yang sedang mengakses variabel untuk 
menggabungkan salinan variabel itu sendiri dengan salinan 
utama pada memori. 

 

Keyword yang termasuk kedalam access modifer dapat dilihat pada tabel 6.2. 

 

Tabel 6.2 Access Modifier 

keyword keterangan 

<default> Modifier <default> tidak memiliki keyword sehingga tidak ada 
yang dituliskan secara eksplisit pada deklarasi modifier ini. 
Modifier <default> dapat diakses oleh class lainnya dalam satu 
paket (package) 

private Keyword private harus ditulis secara eksplisit pada deklarasi. 
Modifier private tidak dapat diterapkan pada class dan 
interface. Method atau data member yang menggunakan 
modifier private hanya dapat diakses didalam class dimana 
tempat pendeklarasiannya. 

protected Keyword protected harus ditulis secara eksplisit pada 
deklarasi. Modifier protected tidak dapat diterapkan pada class 
dan interface. Variabel, method dan konstruktor yang 
menggunakan modifier protected dapat diakses pada paket 
(package) yang sama atau sub class pada paket yang 
berbeda. 
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public Keyword public harus ditulis secara eksplisit pada deklarasi. 
Variabel, method, konstruktor, class dan lain sebagainya yang 
menggunakan modifier public dapat diakses diseluruh ruang 
lingkup kerja Java. 

 

Access modifier akan dibahas lebih lanjut pada materi pemrograman berorientasi 

objek. 

 

6.4 Latihan 

6.4.1 Aplikasi Warna 

 Aplikasi Warna pada percobaan modul 3, terdapat beberapa kode program yang 

berulang-ulang dengan nilai yang berbeda satu dengan yang lainnya seperti pada 

potongan kode program di bawah ini. 

 
Pola antara ‘case 0’ dengan case-case yang lainnya memiliki kode program yang sama 

yaitu : 
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namun dengan nilai warna yang berbeda-beda sesuai dengan ketentuan warna. Oleh 

karena itu, kode program di atas dapat disederhanakan menggunakan method. 4 baris 

kode program dapat dipisahkan kedalam sub kode program menggunakan method 

dengan satu parameter yaitu nilai warna sehingga didalam kode program pernyataan 

switch, programer hanya memanggil nama method dan memberikan nilai warna sesuai 

pilihan pada case_selector. Berikut adalah percobaan membuat aplikasi warna 

menggunakan method. 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’ dengan langkah-

langkah seperti pada percobaan modul 1 (New Package). Beri nama paket 

dengan ‘Modul6’. 

 
 

2. Tambahkan ‘JFrame Form’ dengan langkah-langkah seperti pada percobaan 

modul 1 (menambah frame form). Beri nama JFrame Form dengan ‘Warna’. 
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3. Desainlah JFrame Form seperti aplikasi warna pada percobaan modul 3. 

 

4. Klik tab ‘Source’ , kemudian ketikkan perintah import seperti 

berikut ini.  

 
 

5. Ketikkan method ‘setWarna’ dalam class Warna seperti berikut ini. 

 
Method ‘setWarna’ digunakan untuk merubah warna latar depan (warna teks) 

dari komponen jLabel1, jLabel2, rbLatar, dan rbTeks. Method ini menggunakan 

satu parameter untuk melewatkan nilai warna yang dikirim/dimasukkan dari luar 

method dan diterapkan untuk merubah warna komponen.  

 

6. Ketikkan kode program berikut pada komponen ‘btnUbah’ dengan Event → 

Action → actionPerformed. 
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Method ‘setWarna’ dipanggil dalam komponen btnUbah pada event 

actionPerformed. Nilai warna diberikan/dimasukkan ke method ‘setWarna’ 
sesuai dengan pilihan dari komponen cboWarna. 

 

7. Pastikan tidak ada tanda seru merah pada kode program Anda. Selanjutnya, 

jalankan program dengan cara klik kanan pada file program (frame) pilih Run 

File atau tekan Shift + F6 pada keyboard. 

 

 

6.4.2 Aplikasi Payroll 

Berikut adalah percobaan membuat aplikasi sederhana untuk menampilkan daftar 

perkalian menggunakan perulangan. 

1. Tambahkan ‘JFrame Form’ dengan langkah-langkah seperti pada percobaan 

modul 1 (menambah frame form). Beri nama JFrame Form dengan ‘Payroll’. 

 
 

2. Desain form menggunakan komponen Desktop Pane, Label, Text Field, Combo 

Box, Radio Button, Button Group, dan Button dari jendela palette. Susun posisi 

komponen pada form dan ubah nilai properti pada Label dan Text Field seperti 

pada gambar di bawah ini. 
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3. Ubah nama variabel dan nilai properti komponen seperti berikut ini. 

Komponen Nama Variabel Properties 

buttonGroup1 grupStatus - 

jTextField1 txtnip text = <kosong> 

jTextField2 txtnama text = <kosong> 

jComboBox1 cmbjabatan model = Direktur, Manager, Kabag, 
Sekretaris, Karyawan, Office Boy 

jRadioButton1 rbmenikah text = Menikah 

  buttonGroup = grupStatus 

jRadioButton2 rbbelummenikah text = Belum Menikah 

  buttonGroup = grupStatus 

jTextField3 txtjumlahanak text = <kosong> 

jTextField4 txtgajipokok text = <kosong> 

jTextField5 txttunjanganistri text = <kosong> 

jTextField6 txttunjangananak text = <kosong> 

jTextField7 txtgajikotor text = <kosong> 

jTextField8 txtpajak text = <kosong> 

jTextField9 txtgajibersih text = <kosong> 

jButton1 btnhapus text = Hapus 

jButton2 btnhitung text = Hitung 

 

4. Klik tab ‘Source’ , kemudian tulis deklarasi variabel seperti 

berikut ini. 
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5. Ketikkan kode program berikut didalam konstruktor class. 

 
 

6. Selanjutnya, ketikkan method ‘Gaji’ sesuai kode program berikut ini. 

 

 
 

7. Ketikkan method ‘TunjanganAnak’ sesuai kode program berikut ini. 
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8. Ketikkan method ‘Menikah’ sesuai kode program berikut ini. 

 
 

9. Ketikkan method ‘BelumMenikah’ sesuai kode program berikut ini. 

 
 

10. Ketikkan method ‘Hitung’ sesuai kode program berikut ini. 
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11. Ketikkan method ‘Hapus’ sesuai kode program berikut ini. 

 

 
 

12. Selanjutnya kembali lagi ke tab Desain. 

 

13. Pada panel navigator, klik kanan pada JFrame → Events → Windows → 

windowOpened. 
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Ketikkan kode program : BelumMenikah(); 

 
 

14. Klik kanan pada ‘cmbjabatan’, kemudian pilih Events → Item → 

itemStateChanged. 
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kemudian ketikkan kode berikut ini: 

 
 

15. Klik kanan ‘rbmenikah’ kemudian pilih Events → Action → actionPerformed. 

Ketikkan kode program berikut ini. 

 
 

16. Klik kanan ‘rbbelummenikah’ kemudian pilih Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

17. Klik kanan pada ‘txtjumlahanak’ kemudian pilih Events → Key → 

keyRealeased. 
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kemudian ketikkan kode berikut ini: 

 
 

18. Klik kanan pada ‘btnhitung’ kemudian pilih Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

19. Klik kanan pada ‘btnhapus’ kemudian pilih Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

20. Compile (F9) dan Run Program melalui menu Run → Run File (Shift + F6). 

 

21. Isikan NIP, Nama, dan Pilih Jabatan, Status, Jika sudah Menikah isikan Jumlah 

anak. Setelah itu klik tombol Hitung maka total gaji akan ditampilkan. 

 

22. Klik Tombol Hapus untuk mengosongkan semua TextField menjadi nilai 0. 
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MODUL 7 

PENGOLAH DATA 

7.  

 

MODUL 7 

PENGOLAH DATA 

 

Pokok Pembahasan : 

• Data Karakter 

• Data String 

• Data Tanggal dan Waktu 

• Latihan 
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7.1 Data Karakter 

 Tipe data char pada pemrograman Java digunakan untuk merepresentasikan 

sebuah nilai karakter tunggal. Nilai char ditandai dengan tanda kutip tunggal seperti 

contoh dibawah ini. 

 
 char huruf = ‘M’; 
 char angka = ‘2’;   
 

Tidak hanya huruf, angka, dan simbol yang dapat digunakan pada data char namun 

juga nilai unicode dari karakter ASCII (American Standart Code for Information 

Interchange) seperti 

 
  char huruf = ‘\u004D’; 
 char angka = ‘\u0032’; 
 

Nilai char yang diawali dengan karakter backslash (\) disebut dengan escape 

sequence. Hal ini menjadi pengecualian khusus bagi nilai char yang hanya dapat 

menyimpan nilai tunggal dimana nilai ‘\u004D’ tidak dianggap sebagai nilai String 

melainkan tetap nilai tunggal karena nilai u004D merupakan nilai unicode untuk 

karakter ‘M’. Dalam pemrograman Java terdapat karakter escape sequence yang 

umum digunakan dan dapat dilihat pada tabel di bawah ini. 

 

Tabel 7.1 Escape Sequences 

Escape 
Sequence 

Keterangan Unicode 

\b Backspace \u0008 

\t Tab \u0009 

\n Baris baru \u000A 

\f Form Feed \u000C 

\r Carriage Return \u000D 

\’ Kutip tunggal \u0027 

\” Kutip ganda \u0022 

\\ Backslash \u005C 

 

Contoh: 
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 Untuk mengolah data karakter lebih lanjut, pemrograman Java telah 

menyediakan Class Character. Berikut beberapa method yang terdapat dalam Class 

Character. 

• isLetter(charValue) merupakan fungsi untuk mengetahui apakah nilai 

char adalah huruf. Fungsi menghasilkan nilai true jika nilai char adalah huruf dan 

sebaliknya. 

• isDigit(charValue) merupakan fungsi untuk mengetahui apakah nilai char 

adalah angka (digit). Fungsi menghasilkan nilai true jika nilai char adalah angka 

dan sebaliknya. 

• isUpperCase(charValue) merupakan fungsi untuk mengetahui apakah nilai 

char adalah huruf besar (kapital). Fungsi menghasilkan nilai true jika nilai char 

adalah huruf besar (kapital) dan sebaliknya. 

• toUpperCase(charValue) merupakan fungsi untuk merubah nilai char 

menjadi huruf besar (kapital). 

• toLowerCase(charValue) merupakan fungsi untuk merubah nilai char 

menjadi huruf kecil. 

 

Contoh : 

 

   
 

Hasil 

Hasil 
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7.2 Data String 

 String merupakan kumpulan karakter (baik huruf, angka, maupun simbol) yang 

berurutan. Dalam pemrograman Java, String termasuk tipe data referensi (sebuah 

class) karena mengolah tipe data primitif yaitu char. Pada semua bahasa 

pemrograman terdapat fungsi untuk memanipulasi data String. Oleh karena itu, 

pemrograman Java menyediakan sebuah class khusus untuk mengolah atau 

memanipulasi kata atau kalimat. Berikut beberapa method pada Class String yang 

akan dibahas. 

• charAt(indeks) adalah fungsi untuk mendapatkan/menghasilkan karakter 

dalam sebuah String berdasarkan indeks (nomor urut posisi karakter dalam 

String). Contoh : 

 

 

    
 

• concat(stringLain) adalah fungsi untuk menggabungkan String dengan 

String yang lainnya (stringLain). Contoh : 

 

 

   
 

• endWith(akhiranKarakter) adalah fungsi untuk menemukan keberadaan 

karakter-karakter pada bagian akhiran dari String. Fungsi akan menghasilkan 

nilai true jika karakter-karakter pada akhiranKarakter sama dengan akhiran 

karakter pada String dan menghasilkan nilai false jika sebaliknya. Contoh : 

Hasil 

Hasil 
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• equals(stringLain) adalah fungsi yang membandingkan String dengan 

String yang lainnya (stringLain). Proses perbandingannya dipengaruhi oleh 

urutan karakter dan besar-kecil huruf pada kedua String. Fungsi ini akan 

menghasilkan nilai true jika urutan karakter dan besar-kecil huruf adalah sama 

pada kedua String, menghasilkan nilai false jika sebaliknya. Contoh : 

 

 

      
 

• equalsIgnoreCase(stringLain) adalah fungsi yang membandingkan 

String dengan String yang lainnya (stringLain). Namun, proses 

perbandingannya tidak dipengaruhi oleh besar-kecil huruf pada kedua String. 

Fungsi ini akan menghasilkan nilai true jika karakter pada kedua String adalah 

sama dan menghasilkan nilai false jika sebaliknya. Contoh : 

 

 

      

Hasil 

Hasil 

Hasil 
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• indexOf(char_String, beginIndex) adalah fungsi yang menghasilkan 

nomor indeks dalam sebuah String berdasarkan karakter. Apabila karakter tidak 

ditemukan dalam String maka fungsi akan menghasilkan nilai -1. Contoh : 

 

 

     
 

Posisi awal proses pencarian karakter pada fungsi indexOf juga dapat 

ditentukan. Apabila posisi awal pencari tidak ditentukan maka proses pencarian 

dimulai dari indeks ke-0. Contoh : 

 

  

    
 

Selain karakter, fungsi indexOf juga dapat melakukan pencarian berdasarkan 

String. 

 

• length() adalah fungsi yang menghasilkan panjang atau banyaknya karakter 

dalam sebuah String. 

• replace(oldchar, newchar) adalah fungsi untuk menggantikan seluruh 

karakter lama (parameter pertama) dengan karakter baru (parameter kedua). 

Contoh : 

Hasil 

Hasil 
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• replaceAll(old_subString, new_subString) adalah fungsi untuk 

menggantikan sub string lama (parameter pertama) dengan sub string baru 

(parameter kedua). Contoh : 

 

 

    
 

• split(subString) adalah fungsi untuk memisah-misahkan string menjadi 

array string. Parameter subString menjadi acuan atau titik pemisah. Contoh : 

 

 

     
 

• substring(beginIndex) adalah fungsi untuk mendapatkan/menghasilkan 

sub string dari sebuah string yang dimulai dari indeks tertentu (beginIndex). 

Contoh : 

Hasil 

Hasil 

Hasil 
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Selain indeks awal, fungsi substring juga dapat menggunakan paramter 

untuk menentukan indeks akhir (endIndex). Contoh : 

 

 

     
 

• toLowerCase() adalah fungsi untuk merubah seluruh huruf dalam string 

menjadi huruf kecil.  Contoh : 

 

 

   
 

• toUpperCase() adalah fungsi untuk merubah seluruh huruf dalam string 

menjadi huruf besar (kapital). Contoh : 

 

 

Hasil 

Hasil 

Hasil 
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7.3 Data Tanggal dan Waktu 

 Data tanggal dan waktu sering digunakan dalam aplikasi. Umumnya digunakan 

pada tanggal lahir, penjadwalan dan sebagainya. Pemrograman Java menyediakan 

Class Date yang terdapat pada paket (package) java.util.Date sehingga 

memudahkan penggunanya untuk memanipulasi data tanggal dan waktu. Mulai 

pemrograman Java versi 8 telah dilengkapi dengan paket baru untuk memanipulasi 

tanggal dan waktu yaitu java.time. Berikut beberapa manipulasi data tanggal dan 

waktu yang akan dibahas. 

• Tanggal dan waktu saat ini 

Untuk mendapatkan tanggal dan waktu saat ini, dapat melalui objek yang 

dideklarasikan sebagai sebagai Date (paket java.util.Date). Contoh : 

 

 

    
 

• Format penulisan tanggal dan waktu 

Pemrograman Java telah menyediakan beberapa format tanggal dan waktu 

dengan pola karakter tertentu menggunakan paket (package) 

java.util.Date. dan paket java.text.SimpleDateFormat. Adapun 

pola karakter tersebut dapat dilhat pada tabel 7.1 di bawah ini. 

 

Tabel 7.2 Pola Huruf Untuk Format Tanggal dan Waktu  

Huruf Komponen Format Hasil Contoh 

G Era designator Text AD 

y Year Year 1996; 96 

Y Week year Year 2009; 09 

M Month in year (context 
sensitive) 

Month July; Jul; 07 

Hasil 

Hasil 
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L Month in year 
(standalone form) 

Month July; Jul; 07 

w Week in year Number 27 

W Week in month Number 2 

D Day in year Number 189 

d Day in month Number 10 

F Day of week in month Number 2 

E Day name in week Text Tuesday; Tue 

u Day number of week 
(1 = Monday, ..., 7 = 
Sunday) 

Number 1 

a am/pm marker Text PM 

H Hour in day (0-23) Number 0 

k Hour in day (1-24) Number 24 

K Hour in am/pm (0-11) Number 0 

h Hour in am/pm (1-12) Number 12 

m Minute in hour Number 30 

s Second in minute Number 55 

S Millisecond Number 978 

z Time zone General time 
zone 

Pacific Standard 
Time; PST; GMT-08:00 

Z Time zone RFC 822 time 
zone 

-800 

X Time zone ISO 8601 time 
zone 

-08; -0800; -08:00 

 

(sumber : https://docs.oracle.com/javase/8/docs/api/java/text/SimpleDateFormat.html) 

 

Contoh 1 – format tanggal dan waktu : 
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Contoh 2 – selisih tanggal menggunakan paket java.util.Date 

 

 

    
 

Keterangan : 

Untuk menggunakan perintah  , terlebih 

dahulu masukkan paket java.util.concurrent.TimeUnit; melalui import 

 
 

Contoh 3 – selisih tanggal menggunakan paket java.time 

Hasil 

Hasil 
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Contoh 4 – selisih waktu menggunakan paket java.util.Date 

 

 

    
 

Contoh 5 – selisih waktu menggunakan paket java.time 

Hasil 

Hasil 
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Contoh 6 – selisih umur menggunakan paket java.time 

 

 

    
 

• Contoh 7 – perbandingan kedua tanggal yang berbeda menggunakan paket 
java.util.Date 

 

 

Hasil 

Hasil 
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Konsep perbandingan kedua tanggal yang berbeda menggunakan paket 

java.time sama dengan paket java.util.Date. Pada paket java.time 

menggunakan method isAfter untuk tanggal setelah tanggal pembanding, 

method isBefore untuk tanggal sebelum tanggal pembanding dan method 

isEqual untuk tanggal sama dengan tanggal pembanding. 

 

 

7.4 Latihan 

7.4.1 Aplikasi Tarif Parkir 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul’. 

Hasil 
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2. Tambahkan ‘JFrame Form’ didalam paket ‘Modul’ dengan langkah-langkah 

seperti pada percobaan modul 1 (menambah frame form). Beri nama JFrame 

Form dengan ‘Parkir’. 

 
 

3. Masukkan komponen Panel dari palette ‘Swing Containers’ kedalam form. Ubah 
ukuran komponen Panel sesuai dengan ukuran form. 

 
 

4. Masukkan komponen Label, Text Field, Combo Box, dan Button dari palette 

Swing Controls kedalam komponen Panel. 
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5. Susun posisi masing-masing komponen tersebut dan ubah nilai properti pada 

komponen Label dan Text Field seperti pada gambar di bawah ini. 

 
 

Seluruh komponen yang digunakan dapat dilihat pada jendela navigator 
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6. Ubah nama variabel beberapa komponen seperti pada tabel di bawah ini. 

Komponen Nama Variabel Properties 

jTextField1 txtInap text = <kosong> 

jTextField2 txtMasuk text = <kosong> 

jTextField3 txtKeluar text = <kosong> 

jTextField4 txtBiaya text = <kosong> 

  editable = false 

jTextField5 txtLama text = <kosong> 

  editable = false 

jComboBox1 cboJenisTarif model = Umum, Inap, Pegawai 

jComboBox2 cboJenisKendara model = Sepeda Motor, Mobil, Bus 

jButton1 btnBayar text = Bayar 

jButton2 btnHitung text = Hitung 

 

 
 

7. Klik tab ‘Source’, ketikkan kode program berikut ini untuk import paket-paket 

yang dibutuhkan. 

 
 

8. Ketikkan kode program method ‘bersihEntry’ berikut ini. 
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Kode program method ‘bersihEntry’ digunakan untuk membersihkan 
(mengosongkan) komponen entri data dari data sebelumnya. 

9. Ketikkan kode program method ‘validasiData’ berikut ini. 

 
Kode program method ‘validasiData’ digunakan untuk memeriksa tempat entri 

data yang masih kosong. Apabila masih komponen entri data masih kosong 

maka akan menampilkan pesan. 

 

10. Ketikkan kode program method ‘tarifJenisKendara’ berikut ini. 
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Kode program method ‘tarifJenisKendara’ untuk menentukan tarif parkir 

berdasakan jenis kendaraan dan jenis tarif. 

 

11. Ketikkan kode program method ‘lamaParkir’ berikut ini. 
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Kode program method ‘tarifJenisKendara’ untuk menentukan tarif parkir 
berdasakan jenis kendaraan dan jenis tarif. 

 

12. Ketikkan kode program method ‘tarifYangDikenakan’ berikut ini. 

 

 
Kode program method ‘tarifYangDikenakan’ digunakan untuk mengkalkulasi tarif 
parkir yang dikenakan dan ditampilkan. 

 

13. Klik kanan komponen ‘cboJenisTarif’ pada jendela navigator → Events → Item 

→ itemStateChanged. Ketikkan kode program berikut ini. 

 
Memanggil method ‘bersihEntry’ pada saat terjadi perubahan nilai/data yang 
dipilih pada komponen cboJenisTarif. 

 

14. Klik kanan komponen ‘txtInap’ pada jendela navigator → Events → Key → 

keyTyped. Ketikkan kode program berikut ini. 

 
Menolak karakter yang diinput selain karakter angka. 

 

15. Klik kanan komponen ‘btnHitung’ pada jendela navigator → Events → Action 

→ actionPerformed. Ketikkan kode program berikut ini. 
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Menjalankan seluruh poses perhitungan tarif parkir. 

 

16. Klik kanan komponen ‘btnBayar’ pada jendela navigator → Events → Action → 

actionPerformed. Ketikkan kode program berikut ini. 

 
Menampilkan pesan dan memanggil method ‘bersihEntry’. 
 

17. Compile (F9) dan Run Program melalui menu Run → Run File (Shift + F6). 

 

 

7.4.2 Aplikasi Belajar Kriptografi 

1. Tambahkan ‘JFrame Form’ didalam paket ‘Modul’. Beri nama JFrame Form 

dengan ‘BelKripto’. 
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2. Masukkan komponen Panel dari palette ‘Swing Containers’ kedalam form. Ubah 
ukuran komponen Panel sesuai dengan ukuran form. 

 
 

3. Masukkan komponen Label, Text Field, Text Area, List, Radio Button, Button 

Group, dan Button dari palette Swing Controls kedalam komponen Panel.  

 
 

Susun posisi masing-masing komponen tersebut dan ubah nilai properti pada 

komponen Label dan Text Field seperti pada gambar di bawah ini. 

 
 

Seluruh komponen yang digunakan dapat dilihat pada jendela navigator 
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4. Ubah nama variabel beberapa komponen seperti pada tabel di bawah ini. 

Komponen Nama Variabel Properties 

jTextArea1 txtPlain text = <kosong> 

  lineWrap = true 

  wrapStyleWord = true 

jTextArea2 txtCipher text = <kosong> 

  lineWrap = true 

  wrapStyleWord = true 

jTextField1 txtKey text = <kosong> 

jList1 listProses model = <kosong> 

ButtonGroup1 grupCipher - 

jRadioButton1 cbCaesar text = Caesar Cipher 

  buttonGroup = grupCipher 

jRadioButton2 cbVigenere text = Vigenere Cipher 

  buttonGroup = grupCipher 

jButton1 btnEnkrip text = Enkrip 

jButton2 btnDekrip text = Dekrip 

 

Nama Komponen yang telah diubah dapat dilihat pada jendela navigator seperti 

berikut ini. 
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5. Klik tab ‘Source’, ketikkan kode program berikut ini untuk import paket-paket 

yang dibutuhkan. 

 
 

6. Ketikkan kode program berikut ini untuk mendeklarasikan variabel global yang 

dibutuhkan. 

 
 

7. Ketikkan kode program berikut ini untuk menjalankan/mengeksekusi method 

‘inisialisasi’ pada konstruktor. 

 
Menjalankan kode program method ‘iniComponents()’ dan ‘inisialisasi()’ 
 

8. Ketikkan kode program method ‘inisialisasi’ berikut ini. 
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Menyimpan nilai/data karakter alfabet (A-Z) dalam objek ArrayList (inisialisasi). 

 

9. Ketikkan kode program method ‘enkripCaesar’ berikut ini. 
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Method ‘enkripCaesar’ digunakan untuk menjalankan proses enkripsi 

menggunakan  teknik enkripsi ‘Caesar’. Teknik enkripsi ini mengganti (substitusi) 
setiap karakter pesan asli (plaintext) dengan cara menambahkan indeks 

karakter alfabet (A-Z) dengan nilai kunci. 

 

10. Ketikkan kode program method ‘enkripVigenere’ berikut ini. 
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Method ‘enkripVigenere’ digunakan untuk menjalankan proses enkripsi 
menggunakan  teknik enkripsi ‘Vigenere’. Teknik enkripsi ‘Vigenere’ sama 
seperti teknik enkripsi ‘Caesar’ namun kunci yang digunakan adalah karakter 

huruf. Indeks setiap karakter pesan asli ditambah dengan indeks karakter kunci. 

 

11. Ketikkan kode program method ‘dekripCaesar’ berikut ini. 
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Method ‘dekripCaesar’ digunakan untuk menjalankan proses dekripsi 

menggunakan  teknik dekripsi ‘Caesar’ yaitu indeks pesan tersandi (ciphertext) 

dikurangi dengan nilai kunci. 

 

12. Ketikkan kode program method ‘dekripVigenere’ berikut ini. 

 



 

141 

 

 

 
Method ‘dekripsiVigenere’ digunakan untuk menjalankan proses dekripsi 

menggunakan  teknik dekripsi ‘Vigenere’ yaitu mengurangi indeks setiap 

karakter dari pesan tersandi (ciphertext) dengan indeks karakter kunci. 

 

13. Ketikkan kode program method ‘prosesEnkrip’ berikut ini. 
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Method ‘prosesEnkrip’ digunakan untuk menjalankan proses enkripsi sesuai 
dengan pilihan dari komponen RadioButton. 

 

14. Ketikkan kode program method ‘prosesDekrip’ berikut ini. 

 
Method ‘prosesDekripsi’ digunakan untuk menjalankan proses dekripsi sesuai 

dengan pilihan dari komponen RadioButton. 

 

15. Klik kanan komponen btnEnkrip pada panel navigator → Events → Actioin --. 

actionPerformed. Ketikkan kode program berikut ini. 
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16. Klik kanan komponen btnEnkrip pada panel navigator → Events → Actioin --. 

actionPerformed. Ketikkan kode program berikut ini. 

 
 

17. Compile (F9) dan Run Program melalui menu Run → Run File (Shift + F6). 
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MODUL 8 

PROJEK APLIKASI 

8.  

 

MODUL 8 

PROJEK APLIKASI 
 

Pokok Pembahasan : 

• Aplikasi MDI 

• Aplikasi Input-Data1 

• Aplikasi Input-Data2 

• Aplikasi CRUD 

• Aplikasi Hangman 

• Aplikasi Alarm 

• Aplikasi Download Manager 
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8.1 Aplikasi MDI 

 Sesuai namanya, aplikasi MDI (Multiple Document Interface) merupakan 

aplikasi yang bisa menampilkan beberapa dokumen sekaligus. Contoh aplikasi MDI 

adalah program aplikasi Micrososft word, Microsoft Excel dan program aplikasi lainnya. 

Di dalam aplikasi MDI, ada 2 pembagian Form. 

• Form Induk : Form terluar yang dijadikan tempat (wadah) untuk menampilkan 

form yang lain. 

• Form Anak : Form yang ditampilkan di dalam form Induk. Form ini terpasang 

seolah-olah menempel di dalam Form induk dan tidak dapat keluar dari 

tampilan Form induk. 

 

Berikut contoh projek menggunakan MDI : 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul7.MDI’. 

  
 

2. Tambahkan ‘JFrame Form’ dengan langkah-langkah seperti pada percobaan 

modul 1 (menambah frame form). Beri nama JFrame Form dengan 

‘FormUtama’. 
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3. Tambahkan komponen Desktop Pane dan Menu Bar pada ‘FormUtama’ seperti 

pada gambar di bawah ini. 
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4. Tambahkan JMenuItem di Menu File dengan Cara klik kanan Menu File → Add 

From Palette → Menu Item 

 
 

5. Ganti Text JMenuItem dengan 'New' caranya klik kanan JMenuItem1 → Edit 

Text 

 

6. Ulangi Langkah 4 dan 5, buat tampilannya seperti berikut : 

 

 
 

7. Buat Variable Global untuk dapat diakses semua method yang ada didalam 

class FormUtama.  

 

8. Tambahkan perintah berikut di dalam constructor FormUtama : 

 

9. Buat Method baru dengan nama "FormBaru" dengan isi berikut : 
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Isi Perintah pada Menu New ( JMenuItem ) dengan cara Klik kanan pada menu 

New → Events → Action → actionPerformed. 

 
 

8 

9 

10 
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Ketikkan kode program seperti berikut : 

 
 

10. Isi Perintah pada Menu Keluar (JMenuItem) dengan cara Klik kanan pada menu 

New → Events → Action → actionPerformed. 

 
 

11. Tambahkan JInternalFrame Form pada project pilih menu File → New File pilih 

Project anda, kemudian pada Categories pilih Swing GUI Forms dan pada File 

Types pilih JInternalFrame Form kemudian klik Next. 

 
 

12. Isikan Class name “IFModul2” dan Pakage “Modul7” kemudian klik Finish. 
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Kemudian desain sama seperti program pada modul2, atau copy paste dengan 

cara : 

Buka Modul2 yang sebelumnya kemudian pilih navigator item jDesktopPane1 

→ klik kanan → Copy. 

 
 

Buka IFModul2 yang sebelumnya kemudian pilih navigator item jInternalFrame 

→ klik kanan → Paste. 

 
 

13. Lakukan hal yang sama (ikuti langkah-langkah 11 s/d 12) untuk membuat file 

jInternalFrame Form untuk ‘IFModul3’, ‘IFModul4’, ‘IFModul5’. 
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14. Ubah nilai properti pada masing-masing InternalFrame, pilih navigator item 

jInternalFrame → klik kanan Properties. Centang Closable sehingga bernilai 

true.  

  
 

15. Kembali pada FormUtama kemudian berikan perintah-perintah untuk memanggil 

form-form yang telah dibuat diatas. 

 

16. Isi Perintah pada Menu Modul2 (JMenuItem) dengan cara Klik kanan pada menu 

Modul 2 → Events → Action → actionPerformed. 

 
 

17. Isi Perintah pada Menu Modul3 (JMenuItem) dengan cara Klik kanan pada menu 

Modul 3 → Events → Action → actionPerformed. 

 
 

18. Isi Perintah pada Menu Modul4 (JMenuItem) dengan cara Klik kanan pada menu 

Modul 4 → Events → Action → actionPerformed. 
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19. Isi Perintah pada Menu Modul5 (JMenuItem) dengan cara Klik kanan pada menu 

Modul 5 → Events → Action → actionPerformed. 

 
 

20. Run Program melalui FormUtama menu Run → Run File (Shift + F6). 

 
 

 

  



 

154 

8.2 Aplikasi Input-Data1 

 Berikut ini adalah cara untuk membuat program input data customer dari Java 

dan Netbeans dan menggunakan database MySQL 

1. Buatlah database dan tabel terlebih dahulu :  
CREATE DATABASE dbjava; 

USE dbjava; 

CREATE TABLE tcustomer ( 

id VARCHAR(6) PRIMARY KEY, 

nama VARCHAR(25), 

nohp VARCHAR(14), 

alamat VARCHAR(100)); 

 

2. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul7.Koneksi’. 

 
 

3. Buatlah JClass caranya, klik kanan pakage Modul7.Koneksi, New → Java Class. 

Beri nama ‘ClassDB’, kemudian klik Finish. 
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4. Tambahkan Library konektor MySQL pada Libraries Project ‘Exercises’ dengan 

cara klik kanan pada folder Libraries → Add Library 

 
 

Pilih MySQL JDBC Driver → klik tombol ‘Add Library’ 

 
 

5. Ketikkan kode progam berikut ini didalam ‘ClassDB’. 
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6. Tambahkan JFrame Form pada paket ‘Modul7.Koneksi’ dan beri nama 

‘FrmInputData’. 

 
 

7. Tambahkan beberapa komponen seperti yang ada di dalam tabel berikut ini: 

Objek Properties Nilai 

jDesktopPane1 
Background Purple [204,0,255] 

Border  Title Border = Data Customer 

JLabel1 text ID 
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JLabel2 text Nama 

JLabel3 text No Hp 

JLabel4 text Alamat 

JTextField1 
text 

Txtid 
Variable Name 

JTextField2 
text 

Txtnama 
Variable Name 

JTextField3 
text 

Txthp 
Variable Name 

JTextArea 
text 

Txtalamat 
Variable Name 

JButton1 
text Simpan 

Variable Name Btnsimpan 

JButton2 
text Batal 

Variable Name Btnbatal 

 

8. Susunan posisi dan ukuran komponen seperti pada gambar dibawah ini: 

 
 

9. Deklarasikan class import berikut : 
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10. Selanjutnya Ketikkan kode berikut ini: 

 
 

Keterangan Kode: 

Method dengan nama ‘bacaId’, digunakan untuk membaca field id pada tabel 

tcustomer. 

 

 

private void simpan() { 

        String id = this.txtid.getText(); 

        String nama = this.txtnama.getText(); 

        String nohp = this.txthp.getText(); 

        String alamat = this.txtalamat.getText(); 

        String st = "Free"; 
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Keterangan Kode: 

Method dengan nama simpan, digunakan untuk menyimpan data pada tabel tcustomer. 

 

11. Selanjutnya di bagian bawah kode perintah: 

 

 

        if ("".equals(this.txtid.getText()) || ("".equals(this.txtnama.getText())) 

                || ("".equals(this.txthp.getText())) || 
("".equals(this.txtalamat.getText()))) { 

            JOptionPane.showMessageDialog(this, "Lengkapi data"); 

        } else { 

            try { 

                Connection c = ClassDB.getkoneksi(); 

                Statement s = c.createStatement(); 

                String sql = "Insert into tcustomer values (?,?,?,?)"; 

                try (com.mysql.jdbc.PreparedStatement  

p= (com.mysql.jdbc.PreparedStatement) c.prepareStatement(sql)) 
{ 

                    p.setString(1, id); 

                    p.setString(2, nama); 

                    p.setString(3, nohp); 

                    p.setString(4, alamat); 

                    p.executeUpdate(); 

                } 

                JOptionPane.showMessageDialog(this, "Sukses Tambah data"); 

            } catch (SQLException e) { 

                System.out.println("Terjadi kesalahan " + e); 

            } finally { 

                bersih(); 

            } 

        } 

    } 
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Keterangan kode: 

Method dengan nama bersih, maksudnya yaitu untuk membersihkan/ mengosongkan 

nilai pada tiap-tiap JTextField dengan tujuan untuk memulai proses baru. 

 

12. Klik kanan pada btnsimpan setelah itu pilih Events → Action → 

actionPerformed. Ketikkan kode perintah:  

 
 

13. Klik kanan pada btnclear setelah itu pilih Events → Action → actionPerformed. 

Ketikkan kode perintah: 

 
 

14. Klik kanan pada txtnama setelah itu pilih Events → Key → KeyTyped. Ketikkan 

kode perintah: 

 
 

15. Kompile dan jalankan dari menu Run → Run File atau tekan Shift + F6. 

16. Id akan otomatis terisi. Isikan Nama, No HP, Alamat kemudian pilih tombol 

Simpan. 

17. Klik Tombol Clear untuk mengosongkan TextField. 

 

  

private void bersih() { 

        bacaId(); 

        txtnama.setText(null); 

        txthp.setText(null); 

        txtalamat.setText(null); 

        btnsimpan.setEnabled(false); 

        txtid.setEnabled(false); 

    } 

simpan(); 

 

bersih(); 

 

btnsimpan.setEnabled(true); 

btnbatal.setEnabled(true); 
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8.3 Aplikasi Input-Data2 

 Berikut ini adalah langkah-langkah untuk membuat program input data transaksi 

dari Java dan Netbeans dan menggunakan database MySQL. Namun sebelum itu 

anda telah menyelesaikan aplikasi input-data1 sebelumnya. 

 

1. Buatlah database dan tabel terlebih dahulu :  
CREATE DATABASE dbjava; 

USE dbjava; 

CREATE TABLE tpenjualan ( 

 invoice VARCHAR(12) PRIMARY KEY, 

 tanggal DATE, 

 id VARCHAR(6), 

 nama VARCHAR(30), 

 status VARCHAR(15), 

 barang VARCHAR(30), 

 harga VARCHAR(12), 

 jumlah VARCHAR(6), 

 diskon VARCHAR(12), 

 bayar VARCHAR(12) 

 ) 

 

2. Tambahkan JFrame Form pada paket ‘Modul7.Koneksi’ dan beri nama 
‘FrmTransaksi’. 

 
 

3. Selanjutnya, tambahkan beberapa komponen seperti yang ada di dalam tabel 

berikut ini: 

Objek Properties Nilai 

jDesktopPane1 Background Green 

JLabel1 text Tanggal 
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JLabel2 text Invoice 

JLabel3 text Id Customer 

JLabel4 text Nama 

JLabel5 text No Hp 

JLabel6 text Alamat 

JLabel7 text Status Member 

JLabel8 text Jenis Barang 

JLabel9 text Harga 

JLabel10 text Jumlah 

JLabel11 text Diskon 

JLabel12 text Total Bayar 

JTextField1 Variable Name txttanggal 

JTextField2 Variable Name txtinvoice 

JTextField3 Variable Name txtid 

JTextField4 Variable Name txtnama 

JTextField5 Variable Name txthp 

JTextArea1 Variable Name txtalamat 

JComboBox1 Variable Name cbostatus 

JComboBox2 Variable Name cbojenis 

JTextField6 Variable Name txtharga 

JTextField7 Variable Name txtjumlah 

JTextField8 Variable Name txtdiskon 

JTextField9 Variable Name txttotal 

JButton1 
text Bayar 

Variable Name btnbayar 

JButton2 
text Simpan 

Variable Name btnsimpan 

 

4. Susunan posisi dan ukuran komponen seperti pada gambar dibawah ini: 



 

163 

 
 

5. Deklarasikan class import berikut : 

 
 

6. Selanjutnya Ketikkan kode program berikut ini: 

 
 

7. Lanjutkan ketik dibahwahnya kode program berikut ini : 
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Keterangan Kode: 

Method dengan nama invoice, digunakan untuk mencari data id invoice pada tabel 

tpenjualan. 

 

 
 

private void invoice(){ 

        String kode = "14000" ; 

        try { 

        Class.forName("com.mysql.jdbc.Driver"); 

            try (Connection cn = 

DriverManager.getConnection("jdbc:mysql://localhost/dbjava", "root", "");  

                Statement smt = cn.createStatement()) { 

                String sql = "SELECT max(invoice) as iv FROM tpenjualan"; 

                ResultSet rs = smt.executeQuery(sql) ; 

                if (rs.next()) { 

                }  else { 

                } 

                txtinvoice.setText((kode+1)); 

            } 

        } catch (ClassNotFoundException | SQLException e) { 

        } 

    } 

 

private void cariId(){ 

        try { 

        Class.forName("com.mysql.jdbc.Driver"); 

            try (Connection cn = 

DriverManager.getConnection("jdbc:mysql://localhost/dbjava", "root", "");  

                Statement smt = cn.createStatement()) { 

                String sql = "SELECT * FROM tcustomer where id ='"+txtid.getText()+"' " ; 

                ResultSet rs = smt.executeQuery(sql) ; 

                if (rs.next()) { 

                txtnama.setText(rs.getString("Nama")); 

                txthp.setText(rs.getString("nohp")); 

                txtalamat.setText(rs.getString("alamat")); 

                } else { 

                JOptionPane.showMessageDialog(null,"Id Customer Tidak 

Terdaftar","INFORMASI",JOptionPane.INFORMATION_MESSAGE) ; 

                txtid.setText(null); 

                txtnama.setText(null); 

                txtid.requestFocus() ; 

                } 

            } 

        } catch (ClassNotFoundException | SQLException | HeadlessException e) { 

        } 

    } 
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private void simpan(){ 

    String iv=this.txtinvoice.getText(); 

    String tgl=this.txttanggal.getText().toString(); 

    String id=this.txtid.getText();  

    String nama=this.txtnama.getText(); 

    String status=this.cbostatus.getSelectedItem().toString(); 

    String barang=this.cbojenis.getSelectedItem().toString(); 

    String harga=this.txtharga.getText(); 

    String jumlah=this.txtjumlah.getText(); 

    String diskon=this.txtdiskon.getText(); 

    String bayar=this.txttotal.getText(); 

 

    String st="Free"; 

    if ("".equals(this.txtinvoice.getText()) || ("".equals(this.txttanggal.getText())) 

            || ("".equals(this.txtid.getText()) || ("".equals(this.txtnama.getText()))  

            || ("".equals(this.cbostatus.getSelectedItem().toString())) || 

("".equals(this.cbojenis.getSelectedItem().toString())) 

            || ("".equals(this.txtharga.getText())) || ("".equals(this.txtjumlah.getText())) 

            || ("".equals(this.txtdiskon.getText())) || ("".equals(this.txttotal.getText())))) 

            { 

            JOptionPane.showMessageDialog(this, "Lengkapi data"); 

        }else{ 

    try {            

            Connection c=ClassDB.getkoneksi(); 

            Statement s= c.createStatement(); 

            String sql="Insert into tpenjualan values (?,?,?,?,?,?,?,?,?,?)"; 

        try (com.mysql.jdbc.PreparedStatement p = (com.mysql.jdbc.PreparedStatement) 

c.prepareStatement(sql)) { 

            p.setString(1, iv); 

            p.setString(2, tgl); 

            p.setString(3, id); 

            p.setString(4, nama);   

            p.setString(5, status); 

            p.setString(6, barang); 

            p.setString(7, harga); 

            p.setString(8, jumlah); 

            p.setString(9, diskon); 

            p.setString(10, bayar); 

            p.executeUpdate(); 

        } 

            JOptionPane.showMessageDialog(this, "Invoice Tersimpan"); 

        }catch(SQLException e) { 

            System.out.println("Gagal Menyimpan " + e); 

        }finally{ 

     bersih(); 

    } 

    } 

    } 
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8. Klik kanan pada cbojenis setelah itu pilih Events → Action → actionPerformed. 

Ketikkan kode program berikut ini:  

 
 

private void bayar(){ 

        txtjumlah.setText("1"); 

        int harga=Integer.parseInt(txtharga.getText()); 

        int jumlah=Integer.parseInt(txtjumlah.getText()); 

        int diskon, nilaidiskon, total ; 

         

        if(cbostatus.getSelectedItem()=="Silver"){ 

        diskon = ((5 * harga)/100); 

        nilaidiskon = harga - diskon ; 

        total = (nilaidiskon * jumlah) ; 

 

        }else{ 

         diskon = ((20 * harga)/100); 

        nilaidiskon = harga - diskon ; 

        total = (nilaidiskon * jumlah) ; 

        } 

        txtdiskon.setText(""+diskon); 

        txttotal.setText(""+total); 

    } 

     

    private void bersih(){ 

        invoice(); 

        txtid.setText(null); 

        txtnama.setText(null); 

        txthp.setText(null); 

        txtalamat.setText(null); 

        cbostatus.setSelectedItem("Pilih"); 

        txtharga.setText(null); 

        txtjumlah.setText("1"); 

        txtdiskon.setText(null); 

        txttotal.setText(null); 

    } 
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9. Klik kanan pada btnbayar setelah itu pilih Events → Action → actionPerformed. 

Ketikkan kode program berikut ini : 

 
 

10. Klik kanan pada txtnama setelah itu pilih Events → Action → MouseClicked. 

Ketikkan kode program berikut ini: 

 
 

11. Klik kanan pada btnsimpan setelah itu pilih Events → Action → 

actionPerformed. Ketikkan kode program berikut ini: 

 
 

12. Compile dan jalankan dari menu Run → Run File atau tekan Shift + F6. 
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8.4 Aplikasi CRUD 

 Dalam pemrograman komputer, CRUD (create, read, update and delete) adalah 

empat fungsi dasar dari penyimpanan persisten. Berikut langkah-langkah untuk 

membuat aplikasi CRUD. 

 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul7.CRUD’. 

 
 

2. Tambahkan Java Interface pada paket ‘Modul7.CRUD’ dan beri nama dengan 

nama “key”. 
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Tulis kode program berikut didalam interface key. 

 
 

3. Pastikan MySQL JDBC Driver telah ditambahkan pada Libraries projek 

‘Exercises’. 

 
 

4. Tambahkan Java Class dan beri nama dengan “koneksi” pada paket 

Modul7.CRUD. 
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5.  Tulis kode program berikut ini didalam class koneksi. 
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6. Tambahkan JFrame Form pada paket Modul7.CRUD dan beri nama dengan 

“FormDataAnggota”.  

 
 

Desainlah form seperti pada gambar di bawah ini : 

 
 

 



 

172 

7. Tulis kode program berikut ini didalam FormDataAnggota. 

 
 

 
 

8. Tambahkan dan Ketik method-method berikut ini dibawah konstruktor : 

Terdapat 6 method yaitu : tabel(), hapusForm(), simpan(), cari(), ubah() 

hapusData() 

 

Method table() 
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Method simpan() 
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Method hapusForm() 

 
 

7.4.1 Tugas : 

Lengkapi listing program form diatas sehingga dapat berfungsi sesuai konsep yang 

dimaksud. 

• Buatlah method cari() : listing yang digunakan untuk mengambil data yang ada 

pada tabel/database. 

• Buatlah method ubah() : listing yang digunakan untuk mengubah atau 

memperbaharui data pada table/database. 

• Buatlah method hapusData() : listing yang digunakan untuk menghapus data 

pada table/database. 

• BUAT DATABASE “dborganisasi” dengan table “anggota” dengan field sesuai 
desai form dengan database MySQL. 
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8.5 Aplikasi Hangman 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul7.Hangman’. 

 
 

2. Tambahkan Java Class dengan nama “Manager” pada paket 

‘Modul7.Hangman’. 

 
 

Tulis kode program seperti berikut ini. 
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3. Tambahkan folder baru pada paket ‘Modul7.Hangman’ dan beri nama ‘image’. 
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4. Masukkan file citra yang dibutuhkan kedalam folder image tersebut dengan cara 

copy (ctrl+c) seluruh file citra kemudian paste (ctrl+v). Seluruh file citra dapat 

diunduh pada link berikut ini :  

https://drive.google.com/drive/mobile/folders/1wkx0OrrELfcB5SEiJfc7-

y3Hq5XxQsi2/1_7pHs_lkhBtCAKknFfPUFebvlzSGiOCh?usp=sharing&sort=13

&direction=a 

 
 

5. Masukkan file ‘kata.txt’ kedalam paket ‘Modul7.Hangman’ dengan cara copy 

(ctrl+c) file tersebut kemudian paste (ctrl+v). File ‘kata.txt’ dapat diunduh pada 
link yang sama di atas. 

 
 

6. Tambahkan JFrame Form dan beri nama dengan ‘FormUtama’ pada paket 

‘Modul7.Hangman’. 
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Desain form seperti berikut ini. 

                 
 

7. Masukkan file citra pada lblImage. Klik Kanan lblImage → Properties → Icon → 

klik tombol . Pilih Package: ‘Modul7.Hangman.image’ kemudian pilih File: 
yang diinginkan. 
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8. Tambahkan import dan variable-variable pada tab ‘Source’ seperti pada gambar 

di bawah ini. 

 
 

9. Ketikkan method-method berikut ini pada tab ‘Source’ FormUtama : 
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10. Klik kanan txtletter → Events → Action → actionPerformed, kemudian ketikkan 

kode program berikut ini : 
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11. Tambahkan library JUnit pada Project Libraries. 

 
 

12. Compile dan jalankan dari menu Run → Run File atau tekan Shift + F6. 

  



 

183 

8.6 Aplikasi Alarm 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul7.Alarm’. 

 
 

2. Tambahkan 3 folder baru pada paket ‘Modul7. Alarm’ dan beri nama masing-

masing adalah ‘form’, ‘icon’, ‘sound’. 

 
 

3. Masukkan file citra yang dibutuhkan kedalam folder icon (Modul7.Alarm.icon) 

dengan cara copy (ctrl+c) seluruh file citra kemudian paste (ctrl+v). Seluruh file 

citra dapat diunduh pada link berikut ini :  

https://drive.google.com/drive/mobile/folders/1wkx0OrrELfcB5SEiJfc7-

y3Hq5XxQsi2/1_7pHs_lkhBtCAKknFfPUFebvlzSGiOCh?usp=sharing&sort=13

&direction=a 

 
 

4. Masukkan file suara (*.wav) yang dibutuhkan kedalam folder sound 

(Modul7.Alarm.sound) dengan cara copy (ctrl+c) file suara kemudian paste 

(ctrl+v). File suara dapat diunduh pada link di atas. 
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5. Pastikan library JUnit telah ditambahkan kedalam Project Libraries. 

 
 

6. Tambahkan JFrame Form pada folder ‘form’ (‘Modul7.Alarm.form’) dan beri 
nama dengan “FormAlarm”. 

 
 

7. Masukkan komponen ‘Popup Menu’ pada panel palette AWT kedalam form. 
Bentuk tidak terlihat pada form namun akan muncul pada navigator.  
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8. Ubah nama variabel komponen Popup Menu menjadi ‘popMenu’. 

     

 
 

9. Tambahkan MenuItem pada komponen Popup Menu tersebut. Klik kanan 

komponen Popup Menu pada panel navigator → Add → MenuItem. 

 
 

kemudian tambahkan Separator. Klik kanan komponen Popup Menu pada panel 

navigator → Add → Separator. 

 
 

dan tambahkan lagi MenuItem pada komponen Popup Menu tersebut. 
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10. Tambahkan komponen-komponen lainnya. Susun posisi masing-masing 

komponen, ubah nilai properti setiap komponen dan ubah nama variabel 

beberapa komponen seperti pada gambar di bawah ini. 

                      
 

Ubah nilai properti ‘label’ pada menuShow menjadi ‘Show’ dan nilai properti 
‘label’ pada menuQuit menjadi ‘Quit’ 
 

11. Pada tab ‘Source’, tambahkan import dan variable-variable pada kode program 

seperti pada gambar berikut ini. 
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12. Edit sintaks “public class FormAlarm extends javax.swing.JFrame” menjadi 

“public final class FormAlarm extends javax.swing.JFrame implements 

Runnable”. 
 

13. Ketikkan method-method berikut ini pada tab ‘Source’ di FormAlarm. 

Variable 

Universal 
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Copy-paste method ini ke bagian ‘Source’ 
public void run() { 
        int hr, min, sec; 
        try { 
            while (true) { 
                Thread.sleep(1000); 
                Calendar now = Calendar.getInstance(); 
                int h = now.get(Calendar.HOUR_OF_DAY); 
                int m = now.get(Calendar.MINUTE); 
                int s = now.get(Calendar.SECOND); 
 
                hr = Integer.valueOf(cbHour.getSelectedItem().toString()); 
                min = Integer.valueOf(cbMinute.getSelectedItem().toString()); 
                sec = Integer.valueOf(cbSecond.getSelectedItem().toString()); 
 
                if (sec < s) { 
                    sec = sec + 60; 
                    min = min - 1; 
                } 
                if (min < m) { 
                    min = min + 60; 
                    hr = hr - 1; 
                } 
                if (hr < h) { 
                    hr = hr + 24; 
                } 
                hr = hr - h; 
                min = min - m; 
                sec = sec - s; 
 
                lblTimer.setText(hr + ":" + min + ":" + sec); 
                if ((hr == 0) && (min == 0) && (sec == 0)) { 
                    AudioInputStream source = 

      AudioSystem.getAudioInputStream(getClass().getResource("../sound/bugsbunny.wav")); 
                    Clip newClip = (Clip) AudioSystem.getLine(new DataLine.Info(Clip.class, source.getFormat())); 
                    newClip.open(source); 
                    newClip.start(); 
                    status = 0; 
                    btnTimer.setIcon(icon); 
                    btnTimer.setText("Start Alarm"); 
                    cbHour.setEnabled(true); 
                    cbMinute.setEnabled(true); 
                    cbSecond.setEnabled(true); 
                    th.stop(); 
                } 
            } 
        } catch (InterruptedException ex) { 
        } catch (NumberFormatException ex) { 
        } catch (UnsupportedAudioFileException ex) { 
        } catch (IOException ex) { 
        } catch (LineUnavailableException ex) { 
        } 
    } 
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14. Tambahkan ActionPerformed pada btnTimer. Klik kanan btnTimer pada panel 

navigator → Events → Actions → actionPerformed. Ketik kode program berikut 

ini. 

 
 

15. Tambahkan ActionPerformed pada menuShow. Klik kanan menuShow pada 

panel navigator → Events → Actions → actionPerformed. Kemudian ketikkan 

kode program : this.show(); 

 

16. Tambahkan ActionPerformed pada menuQuit. Klik kanan menuQuit pada panel 

navigator → Events → Actions → actionPerformed. Kemudian ketikkan kode 

program : System.exit (0); 

 

17. Running Program, atur waktu alarm kemudian start alarm . 
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8.7 Aplikasi Download Manager 

1. Tambahkan paket (Java Package) pada projek ‘Exercises’. Beri nama paket 

dengan ‘Modul7.JavaDownload’. 

 
 

2. Tambahkan Java Class pada paket ‘Modul7.JavaDownload’ dan beri nama 

dengan “Download”. 

 
 

Ketikkan import yang dibutuhkan seperti berikut ini pada class Download. 
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Ubah public class Download  

 
menjadi 

 
 

selanjutnya ketikkan kode program berikut ini didalam  

 

copy-paste kode program berikut ini 
 
    static String action[] = {"Downloading", "Paused", "Complete", "Error"}; 
    int DOWNLOADING = 0; 
    int PAUSED = 1; 
    int COMPLETE = 2; 
    int ERROR = 3; 
    URL url; 
    int size, downloaded, status; 
    File directory; 
 
    public Download(URL url, File dest) { 
        this.url = url; 
        String strURL = url.toString(); 
        this.directory = new File(dest.getAbsolutePath() + System.getProperty("file.separator") + 
strURL.substring(strURL.lastIndexOf('/') + 1)); 
        size = 0; 
        downloaded = 0; 
        status = DOWNLOADING; 
        Thread thread = new Thread(this); 
        thread.start(); 
    } 
 
   public void pauseDownload() { 
        status = PAUSED; 
        update(); 
    } 
 
    public void resumeDownload() { 
        status = DOWNLOADING; 
        update(); 
        Thread thread = new Thread(this); 
        thread.start(); 
    } 
 
   private void error() { 
        status = ERROR; 
        update(); 
    } 
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copy-paste kode program berikut ini (lanjutan sebelumnya) 
 
 
   public String getFileName() { 
        return url.toString().substring(url.toString().lastIndexOf('/') + 1); 
    } 
 
    public int getSize() { 
        return size; 
    } 
 
    public float getProgress() { 
        return ((float) downloaded / size) * 100; 
    } 
 
    public int getStatus() { 
        return status; 
    } 
 
    private void update() { 
        setChanged(); 
        notifyObservers(); 
    } 
 
    public void run() { 
        RandomAccessFile file = null; 
        InputStream stream = null; 
        try { 
            HttpURLConnection connection = (HttpURLConnection) url.openConnection(); 
            connection.connect(); 
            if (connection.getResponseCode() != 200) { 
                error(); 
            } 
            int contentLength = connection.getContentLength(); 
            if (contentLength < 1) { 
                error(); 
            } 
            if (size == 0) { 
                size = contentLength; 
                update(); 
            } 
            file = new RandomAccessFile(directory, "rw"); 
            file.seek(downloaded); 
            stream = connection.getInputStream(); 
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3. Tambahkan Java Class pada paket ‘Modul7.JavaDownload’ dan beri nama 

dengan “TableModel”. (Download listing di edmodo) 

 
 

Ketikkan import yang dibutuhkan seperti berikut ini pada class TableModel. 

 

copy-paste kode program berikut ini (lanjutan sebelumnya) 
 
 
           while (status == DOWNLOADING) { 
                byte buffer[]; 
                buffer = new byte[size - downloaded]; 
                int read = stream.read(buffer); 
                if (read == -1) { 
                    break; 
                } 
                file.write(buffer, 0, read); 
                downloaded += read; 
                update(); 
            } 
            if (status == DOWNLOADING) { 
                status = COMPLETE; 
                update(); 
            } 
        } catch (Exception e) { 
            error(); 
        } 
    } 
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Ubah public class TableModel 

 
menjadi 

 
 

selanjutnya ketikkan kode program berikut ini didalam  

 
 

copy-paste kode program berikut ini 
 
    String[] columnNames = {"File Name", "Size", "Progress", "Status"}; 
    ArrayList downloadList = new ArrayList(); 
 
    @Override 
    public String getColumnName(int col) { 
        return columnNames[col]; 
    } 
 
    public int getRowCount() { 
        return downloadList.size(); 
    } 
 
    public int getColumnCount() { 
        return columnNames.length; 
    } 
 
    public void update(Observable o, Object arg) { 
        int index = downloadList.indexOf(o); 
        fireTableRowsUpdated(index, index); 
    } 
 
    public Object getValueAt(int rowIndex, int colmIndex) { 
        Download download = (Download) downloadList.get(rowIndex); 
        if (colmIndex == 0) { 
            return download.getFileName(); 
        } else if (colmIndex == 1) { 
            return download.getSize(); 
        } else if (colmIndex == 2) { 
            return String.valueOf((int) download.getProgress()) + " %"; 
        } else if (colmIndex == 3) { 
            return Download.action[download.getStatus()]; 
        } else { 
            return ""; 
        } 
    } 
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4. Tambahkan folder baru pada paket ‘Modul7.JavaDownload’ dan beri nama 

‘icon’. 

 
 

5. Masukkan file citra yang dibutuhkan kedalam folder icon 

(Modul7.JavaDownload.icon) dengan cara copy (ctrl+c) seluruh file citra 

kemudian paste (ctrl+v). Seluruh file citra dapat diunduh pada link berikut ini :  

https://drive.google.com/drive/mobile/folders/1wkx0OrrELfcB5SEiJfc7-

y3Hq5XxQsi2/1_7pHs_lkhBtCAKknFfPUFebvlzSGiOCh?usp=sharing&sort=13

&direction=a 

copy-paste kode program berikut ini (lanjutan sebelumnya)  
 
    public void addDownload(Download download) { 
        download.addObserver(this); 
        downloadList.add(download); 
        fireTableRowsInserted(getRowCount() - 1, getRowCount() - 1); 
    } 
 
    public Download getDownload(int row) { 
        return (Download) downloadList.get(row); 
    } 
 
    public void clearDownload(int row) { 
        downloadList.remove(row); 
        fireTableRowsDeleted(row, row); 
    } 



 

197 

 
 

6. Pastikan library JUnit telah ditambahkan kedalam Project Libraries. 

 
 

7. Tambahkan JFrame Form pada paket ‘Modul7.JavaDownload’ dan beri nama 

dengan “FormUtama”. 

 
 

8. Masukkan komponen ‘Tool Bar’ dan ‘Scroll Pane’ kedalam form. 

 
 

kemudian masukkan komponen ‘Table’ di dalam komponen ‘Scroll Pane’, 
komponen ‘Button’ dan ‘Separator’ di dalam komponen ‘Tool Bar’. 
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9. Ubah nama variabel dan nilai properti beberapa komponen seperti pada tabel di 

bawah ini. 

Komponen Nama Variabel Properties 

jButton1 btnAdd text = add 

  icon = add.png 

jButton2 btnResume text = resume 

  icon = resume.png 

  enabled = false 

jButton3 btnPause text = pause 

  icon = pause.png 

  enabled = false 

jButton4 btnStop text = stop 

  icon = delete.png 

  enabled = false 

jTable1 tblDownload - 

 

10. Untuk memasukkan file citra (icon) kedalam komponen ‘Button’, klik kanan 

komponen ‘Button’ → Properties → Icon → klik tombol . Pilih Package: 

‘Modul7. JavaDownload.icon’ kemudian pilih File: yang diinginkan.  
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11. Pada tab ‘Source’, ketikkan kode program berikut ini 

 
 

12. Tambahkan ActionPerformed pada btnAdd. Klik kanan btnAdd pada panel 

navigator → Events → Actions → actionPerformed. Ketik kode program berikut 

ini. 

 
 

13. Tambahkan ActionPerformed pada btnPause. Klik kanan btnPause pada panel 

navigator → Events → Actions → actionPerformed. Ketik kode program berikut 

ini. 
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14. Tambahkan ActionPerformed pada btnResume. Klik kanan btnResume pada 

panel navigator → Events → Actions → actionPerformed. Ketik kode program 

berikut ini. 

 
 

15. Tambahkan ActionPerformed pada btnStop. Klik kanan btnStop pada panel 

navigator → Events → Actions → actionPerformed. Ketik kode program berikut 

ini. 

 
 

16. Tambahkan Event MouseClicked pada tblDownload. Klik kanan tblDownload 

pada panel navigator → Events → Mouse → mouseClicked. Ketik kode 

program berikut ini. 

 
 

17. Tambahkan JDialog Form pada paket ‘Modul7.JavaDownload’ dan beri nama 

dengan “InputDownload”.  
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18. Masukkan komponen ‘Label’, ‘Text Field’, dan ‘Button’ kedalam form 
“InputDownload”. Susun posisi masing-masing komponen, ubah nilai properti, 

dan ubah nama variabel beberapa komponen sesuai dengan gambar di bawah 

ini. 

      
 

19. Pada tab ‘Source’, ketikkan kode program seperti pada gambar berikut ini. 
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20. Ketikkan method-method dibawah : 

 
 

21. Tambahkan ActionPerformed pada btnBrowse. Klik kanan btnBrowse pada 

panel navigator → Events → Actions → actionPerformed. Kemudian ketikkan 

kode program berikut ini. 

 
 

22. Tambahkan ActionPerformed pada btnDownload. Klik kanan btnDownload pada 

panel navigator → Events → Actions → actionPerformed. Kemudian ketikkan 

kode program berikut ini. 
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23. Running Program (Shift + F6), klik Button Add  masukkan URL file yang 

akan di download. 

 

Contoh URL :  

http://download1974.mediafire.com/w8x8d9n50f1g/kapzfpejq8e4woy/smadav1

0.exe 

 
 

 

http://download1974.mediafire.com/w8x8d9n50f1g/kapzfpejq8e4woy/smadav10.exe
http://download1974.mediafire.com/w8x8d9n50f1g/kapzfpejq8e4woy/smadav10.exe
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